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Poznámka:  
Informace uvedené v následujícím textu mohou být změměny bez předchozího upozornění. Kopírování nebo 
elektronické rozšiřování částí dokumentu je zakázáno bez písemného souhlasu. Burster žádným způsobem 
neodpovídá za vybavení. Toto prohlášení platí také pro obchodní kvalitu a vhodnost pro specifické účely. 
Burster není za žádných okolností zodpovědný za chyby způsobující náhodné poškození nebo závažné 
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Seznam zařízení (Device List) 
 
 

 
Zařízení DIGIFORCE 9310 je detekováno jako zařízení nebo stanice. 
  
Seznam zařízení je dostupný pouze po detekci zařízení (Device Search), když byl přístroj 
DIGIFORCE 9310 nalezen. 
Pokud je do počítače připojeno více zařízení přes převodník RS 485 bude uvedeno více zařízení 
v seznamu po nadetekování pomocí hledání zařízení (Device Search). 
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Před výběrem požadované operace s příslušným zařízením musí být zařízení vybráno ze seznamu. 
Příslušný název přístroje nebo sériové číslo se objeví ve většině dialogových oken. 
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Kontrolní součet - Digitální podpis           
File Checksum - Digital Signature 
 
Kontrolní součet (digitální podpis je kontrolní součet všech parametrů a dat spojených se souborem. 
Tento digitální podpis je integrován v záloze (Backup), protokolu, statistice a informuje o případné 
manipulaci se souborem po jeho vytvoření. 
 
Soubor je označen za změněný pokud byly údaje v něm obsažené ručně změněné a následně uloženy. 
 
Vezměte na vědomí, že digitální podpis je přítomný v programu DigiControl  od verze 2003.1.0. 
 
 
 
 
 

Verze nápovědy 
 
Tento dokument odkazuje na DigiControl 9310 ve verzi V2004.5.0. 
 
2002-2004 © burster präzisionsmeßtechnik gmbh & co kg 
Creator: Thomas Meder / 03.12.2004  
 
 
 
 
 

Kontakt výrobce 
 
Pokud máte dotazy týkající se DigiControl 9310 nebo DIGIFORCE 9310, Můžete kontaktovat 
výrobce na adrese: 
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Známé problémy 
 

Chyba formátování/výpočtu (Formatting / Calculating Error) 
V některých operačních systémech program DigiControl nepodporuje čárku jako symbol oddělení celé 
a desetinné části čísla. V těchto případech dostanete zprávu z programu DigiControl a musíte provést 
změnu desetinné čárky na desetinou tečku. Jinak DigiControl nepracuje bez chyb. 
 

Problém se zobrazením textu 
Nastavení velikosti písma (Font Size) v operačním systému musí být nataveno na malé nebo velké 
písmena. 
Neměňte velikost písma na vybrané uživatelem (user-defined) nebo nastavení jiná velikost písma 
(Other Font Size) jinak se mohou objevit některé problémy se zobrazením. 
V těchto případech dostanete upozornění od programu DigiControl 9310. 
 

Problémy s tiskem/uložením hlášení a protokolů 
 
Pro tisk protokolů a hlášení potřebujete přístup (pro čtení i zápis) do složky, kde je program 
DigiControl 9310 nainstalovaný. V případě nutnosti kontaktujte administrátora systému. 
 

Komunikace s DIGIFORCE 9310 
Komunikace s přístrojem je možná pomocí dvou sériových rozhraní: RS 232 (konektor ze přední 
strany přístroje DIGIFORCE 9310) a RS 485 plně duplexní (ze zadní strany přístroje DIGIFORCE 
9310). 
 
Pokud máte nějaké problémy při komunikaci prosím přečtěte si často kladené otázky (FAQ). 
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Často kladené otázky (FAQ) 
 
••••    Jak můžu měřící program kopírovat? 

Podívejte se do instrukcí do části o kopírování. 
 
••••    Můžu nainstalovat a spustit vícekrát program DigiControl 9310 na stejném počítači? 

Program DigiControl 9310 může být nainstalován a spuštěn pouze jednou na počítači. 
 
••••    Je program DigiControl kompatibilní se všemi staršími a novějšími verzemi zařízeními 

DIGIFORCE 9310? 
Program DigiControl 9310 by měl být kompatibilní se všemi verzemi přístrojů DIGIFORCE 9310.  
Ale pokud je verze software přístroje DIGIFORCE 9310 novější než je verze programu 
DigiControl 9310 a nějaké nové vlastnosti jsou nerozpoznané musíte provést upgrade programu 
DigiControl 9310. 
Pokud máte nějaké jiné problémy kontaktuje naší softwarovou podporu: Software@burster.de. 

 
••••    Proč DigiControl nenašel žádné zařízení při hledání zařízení (device search)? 

• Zkontrolujte zda je propojovací kabel zapojený a nepoškozený. 
• Konektor pro rozhraní RS 232 ze přední strany zařízení není běžný 3,5 mm stereo audio jack, 

ale je speciální. Proto byste měly použít originální propojovací kabel od burstera! 
• Případně zkontrolujte vodivost jednotlivých vodičů kabelu. 
• Zkontrolujte, zda je nastavení rozhraní programu DigiControl a DIGIFORCE identické. 
• Ujistěte se zda jste opustili menu “RS232 + RS485” v DIGIFORCE 9310, když jste začali 

komunikovat se zařízením, protože před opuštěním menu nejsou změny aktivní. 
• Je vybraný port (COM) nainstalovaný a nastavený v počítači? 
• Je vybraný port (COM) použitý jiným zařízením nebo jiným ovladačem? 

V mnoha případech je synchronizační manažer PDA nebo organizérů nainstalován a 
spuštěn na pozadí! 

• Poznámky pro používání rozhraní RS 485 jsou zde popsány. 
 
••••    DigiControl 9310 by měl být kompatibilní se všemi verzemi přístroje DIGIFORCE 9310. 
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Hledání zařízení (Find Device) 
 
Před začátkem hledání zařízení musíte v programu DigiControl 9310 (General Settings -> Interfaces) 
nastavit shodné nastavení pro komunikaci jako jsou nastavené v zařízení DIGIFORCE 9310 (menu 
”RS232 + RS485”). U jednoduchého hledání  bude hledáno zařízení jen podle nastavených parametrů. 
Z tohoto důvodu je nezbytné dávat pozor na tovární nastavení rozhraní!  
Mějte na vědomí, že existující seznam zařízení bude smazán v průběhu každého hledání.  
Kromě toho se před začátkem hledání  ujistěte, že na přístroji DIGIFORCE 9310 není aktivní menu 
”RS232 + RS485”. Jinak nastavení zařízení nebude ještě aktivní.  
 
Existuje několik variant při hledání zařízení na sběrnicích:  
 

Jednoduché hledání zařízení 
Pokud chcete hledat zařízení podle parametrů zadaných v nastavení programu DigiControl, jednoduše 

kliknete na tlačítko Hledání zařízení . 
O stavu hledání informuje modrý sloupcový ukazatel průběhu. 
Pokud jsou všechny připojené zařízení zobrazeny v seznamu zařízení můžete stisknout tlačítko Cancel 
i před dokončení hledání. Tato zručení hledání nebude to mít vliv na již detekované zařízení.  
 
Po dokončení hledání budete informováni o počtu zařízené, které byly nalezeny. 
  

 
 

Rozšířené hledání (Extended Device Search) 
Pro spuštění rozšířeného hledání držte klávesu <ALT> v době, když klikáte na tlačítko Hledání 

zařízení  . Po zmáčknutí tlačítka se objeví okno s výběrem, kde mohou být 
definovány rozšířené parametry hledání před jeho zahájením: 
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Při hledání je možné zahrnout změnu některých parametrů. Jde o parametry: přenosová rychlost (Baud 
rate settings), kontrola bloků dat (Blockcheck) se dvěmi variantami nastavení na zapnuto (On) 
a vypnuto (Off) a všechny formáty dat (Data formats) pro automatickou detekci DIGIFORCE 9310. 
 
Pokud je zařízení detekováno máte možnost hledat další zařízení se stejným nastavením parametrů. 
K tomu je nutné potvrdit následující dialogové okno kliknutím na tlačítko Ano (Yes) nebo pomocí 
kliknutí na tlačítko Ne (No) pro vybrání detekovaného zařízení jako jediného: 
 

 
 
Důležitá poznámka: Mějte na vědomí, že je zde až 27 500 variant nastavení parametrů během 
definice rozsahu hledání. Výsledkem toho je, že hledání může trvat až několik dní. Proto specifikujte 
hledání co nejvíce. 
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Nastavení stanice (Station Properties) 
[Dvojitým kliknutím na stanici v seznamu zařízení] 
 

 
 
V titulku dialogového okna je vidět název stanice, výrobní číslo, a verzi software přístroje 
DIGIFORCE 9310.  
 

Obecné (General) 
V dialogovém okně jsou uvedeny charakteristiky, které specifikují zařízení. Jedná se o kalibrační 
datum (Calibration Date), verzi software (Software Version) a výrobní číslo (Serial numer) přístroje 
DIGIFORCE 9310. 
 
Dále v DigiControl 9310 můžete měnit nebo upravovat jméno stanice (Station Name). Tato položka je 
také uložena v přístroji DIGIFORCE 9310 jako položka název stanice (Station Name). Maximální 
délka názvu je 10 znaků. 
Položka adresa (Address) nemůže být změněna. Je přiřazena individuálně při hledání zařízení. 
 
Všechny změny se uloží pouze pokud kliknete na tlačítko OK. Tlačítkem Cancel zahodíte veškeré 
změny, které jste učinili! 
 
Poznámka: Pokud v přístroji není uloženo datum kalibrace v položce Calibration Date pole se 
zvýrazní a zbarví se červeně. Jako další se objeví text DIGIFORCE 9310 „should not be used in this 
condition“ (přístroj by za těchto podmínek neměl být používán)! 
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Překladač příkazů (Command Interpreter) 
[Označte stanici v seznamu zařízení -> Edit -> Command Interpreter] 

 
 
 
Tímto překladačem příkazů je možné posílat přes sériové rozhraní příkazy, které jsou popsány 
v manuálu DIGIFORCE 9310. 
Toto je například praktické, pokud vytváříte vlastní program a chcete otestovat specifické příkazy 
a jejich funkčnost.  
K vyvolání tohoto okna vyberte stanici v seznamu zařízení (device list). Nyní následujte postup:  
‘Edit’  ->‘Command Interpreter’ . 
V titulku okna jsou vypsány údaje o přístroji pro jeho identifikaci. Jedná se o název stanice a sériové 
číslo. 

 
 
S nastavením pouze příchozí zprávy (Only accepted commands) vyvoláte vnitřní paměť programu 
DigiControl pro všechny příkazy, které byly poslány a jsou správné. 
 
Nyní například vložíte příkaz INFO? do kolonky Command Send String a kliknete na tlačítko Send. 
Zařízení vrátí informace do pole Command Receive String.  
 
Opuštění tohoto okna se provede kliknutím na tlačítko Quit nebo křížkem v titulku okna. 
 
Poznámka: Pokud je řetězec poslaných znaků neplatný, obsahuje neplatné parametry nebo se 
vyskytne jiná chyba objeví se tato zpráva, když kliknete na poslat. 
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Výběr zařízení (Device Selection) 
 
 

 
 
 
Pokud zpracovávání parametrů bylo zahájeno offline ze záložního souboru (backup)  nebo kompletně 
od začátku a zařízení je vloženo do seznamu zařízení můžete vybrat stanici pro odeslání parametrů. 
 
Berte na vědomí, že pouze program nebo zpracované parametry jsou vysílány do zařízení. Existující 
nastavení je v průběhu procesu smazáno!  
Vyberte zařízení (pokud je v nabídce více zařízení) a potvrďte výběr stisknutím tlačítka Continue. 
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Měřící mód (Measurement Mode) 
 [Dvojité kliknutí na stanici v listu zařízení -> Measurement Mode] 
 

 
 
Nastavte parametry pro měření v této záložce. 
 
 

Sběr dat (Data Collection) 
Vyberte jaký druh informací skutečně chcete sbírat a vysílat z DIGIFORCE – Odděleně pro výsledek 
OK a NOK. 
 
1) Pouze hlavní výsledek (Only general results) 
S tímto nastavením budou vysílány jen základní údaje o křivce a celkový výsledek měření (OK/NOK). 
 
2) Základní výsledek a změřená křivka (General result and measurmement curve) 
Jako případ 1] s přidáním změřených dat křivky. 
 
3) Základní výsledek, okno, obálka (General, Window and Envelope results) 
Jako případ 1], navíc bude posláno nastavení a výsledky všech aktivních oken s jejich vyhodnocením 
a výsledek obálky.  
 
 
 
 



Operační  manuál                                                    PC-Software  DigiControl 9310                                                        Strana 17 z 121   

4) Výsledek celkový, oken, obálky, měření, obálka a křivka trendu     
(General, Window and Envelope results; Measurement, Envelope and Trend curve) 
Oproti bodu 3] navíc obsahuje posílání křivky trendu a aktivní obálky. Toto nastavení potřebuje 
nejdelší čas pro přenos dat. 
 
Důležitá poznámka: jen poslaná data mohou být kdykoli zpracovávána. Tohoto byste si měli být 
vědomi, pokud chcete analyzovat změřená data.  
 
Postřeh (Remark) 
Upravte postřehy (max. 64 znaků), které budou uloženy s každým měřícím protokolem. Tyto postřehy 
jsou viditelné při tisku protokolů.  
 

Číslování (Charge) 
Můžete vybrat mezi manuální a automatickou definicí založenou na aktuálním čase.  
 

Výrobní číslo (Part-No.) 
Výrobní číslo je tvořeno čítačem , který je umístěn v DIGIFORCE. 
Volitelně do polí %1 a/nebo %2 může být zadán blok alfanumerických znaků s maximální délkou 32 
znaků. 
 
Poslední číslo části (Last Part-No.) 
V tomto poli můžete vidět poslední použitou hodnotu Part-No, která byla použita pro vytvoření 
protokolu měření. Můžete ji ručně změnit. 
 
Následující číslo čítače (Next Counter No.) 
V tomto poli je uvedena hodnota Part-No., která bude použita pro vytvoření dalšího protokolu měření. 
Tato hodnota musí být větší nebo rovna 0 a bude nastavena na 1 pokud je číslo větší než 2147483647. 
 
 

Výrobek (Component) 
Můžete vybírat mezi názvem příslušného programu v DIGIFORCE a ruční deklarací. 
Nicméně je smysluplné použít výmluvné jméno názvu součásti (component name), aby bylo možné 
pozdější přiřazení součásti. 
Maximální délka názvu součásti (component name) je 32 znaků. 
 
 

Poznámka: Aktivní skupina zařízení 
Pokud je aktivní skupina zařízení nastavení Charge, Part-No. a Component Name odkazuje pro 
všechny zařízení. 
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Statistika (Statistic) 
 [Dvojité kliknutí na jméno stanice v seznamu zařízení -> Statistic] 
 

 
 
Graficky bude znázorněna statistika správných (OK) a vadných (NOK) měření pro celý den (24 
hodin). 
Každý den statistika začíná od začátku pokud je měřící mód aktivní. 
Prezentace dat je volitelně paralelní nebo mezi sebou. 
 



Operační  manuál                                                    PC-Software  DigiControl 9310                                                        Strana 19 z 121   

Nastavení (Parameterize) 
[Parameterize (New, from File, online)] 
 

 
 
Můžete vytvořit nový parametrizační soubor (File -> New), otevřít soubor ze zálohy (backup) nebo 
přečíst parametry ze zařízení, které je připojené (online). 
 
Pokud otevřete parametrizační okno u zařízení, které je připojené jméno programu bude zobrazeno na 
tlačítku. Platí pro DIGIFORCE 9310 software verze V200303 a vyšší. 
 
Můžete přepínat mezi následujícími záložkami po otevření okna parametrizace:  
 

Základní nastavení (General Settings) 
Základní nastavení parametrů v DIGIFORCE 9310: 
• Uživatelský jazyk (User language) 
• Způsob zobrazení OK/NOK 
• Kontrast Displaye (LCD contrast) 
• Aktuální obrazovka vyhodnocení (Current display mode) 
• Nastavení sběrnice Profibus (volitelně) (Profibus settings (optional)) 
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Přístupová práva (Access Permission) 
• Přiřazení hesla masterovi a uživateli (Assignment of master and user passwords) 
• Aktivace ochrany (Protection activation) 
• Přístupová práva pro uživatele (Access levels for users ) 
 

Programy (Programs) 
• Výběr čísla aktivního programu (Active program specification) (0 –7) 
• Nastavení programů (Selection of program to be processed) (0 – 7) 
• Kopírování programů (Copying of programs) 
 
 

Uložení parametrů zařízení (Save Device Parameter) 
Data ze všech parametrizačních oken mohou být uložena v záložním souboru. Pokud soubor už 
existuje, můžete přidat parametry do souboru ‘Supplement’ nebo nahradit ‘Replace’ soubor úplně 
(soubor je smazán a vytvořen nový s těmito parametry): 
 

 
 

Vysílání 
Data ze všech parametrizačních oken jsou vyslány do zařízení pomocí následujícího potvrzení a dialog 
je uzavřen. 
  

Zrušení (Cancel) 
Dialogové okno je zavřeno bez jakýchkoliv změn v zařízení. Pokud chcete první uložit data , klikněte 
na Save Device Parameter nebo na pole Transmit. 
 
 
Poznámka: Jakmile jste změnili alespoň jeden parametr v Parameterize dialog stav byl změněn na 
hodnotu not saved/transmitted (neuložen/nevyslán). Pokud jste zvolili tlačítko Cancel 
v parametrizačním dialogu zahodili jste provedené změny (s příjmutím bezpečnostní zprávy, kterou 
můžete deaktivovat a pokud je potřeba aktivovat v General Settings – Presentation). Parameterizační 
okno obsahuje následující stránky: Basic Settings, Access Permission a Programs. 
Zněny, které jste udělali budou provedeny pouze pokud kliknete na tlačítko Transmit  v 
Parameterizačním dialoug nebo pokud změny provedete stisknutím tlačítka Save Device Parameter. 
 
Mějte na paměti, že jsou ukládána nebo vysálána pouze data  parametrizační dialogu (a ne parametry 
programů 0 – 7!).
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Základní nastavení (Basic Settings) 

[Parameterize (New, from File, online) -> Basic Settings] 
 

 
 

Jazyk menu přístroje (Operation Language) 
Nastavení jazyka menu přístroje DIGIFORCE 9310.  
 
 

OK/NOK Display 
NOK Part: Výsledek vadných (NOK) částí může být zobrazen jako procentní hodnota 

z celkového počtu měření nebo jako absolutní počet. 
Display: Můžete buď zvolit text (Text OK nebo NOK je zobrazen) nebo a ”smajlík” pro 

celkový přehled měření. 
  
 

Display 
LCD Contrast: Nastavení kontrastu displeje použitím táhla. Vstupní hodnoty jsou od 

0 (světlý) po 9 (tmavý) 
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Současné nastavení displeje (Current Display Mode) 
Určete, které nastavení menu displeje bude aktivní při vysílání parametrů. Tento požadavek odpovídá 
s Display Mode (Programs – záložka Presentation) v Active Program (Parameterize Programs)  
 

Profibus (volitelně) 
Address:  Adresa zařízení při komunikaci přes Profibus (0-127) 
Digital Inputs:  Definice digitálních vstupů. Výběr mezi SPS a Profibus. 
Monitoring:  Monitorování sítě (nastavení On nebo Off). 
 
 

Uložení parametrů zařízení (Save Device Parameter) 
Data ze všech parametrizačních oken mohou být uložena v záložním souboru. Pokud soubor už 
existuje, můžete přidat parametry do souboru ‘Supplement’ nebo nahradit ‘Replace’ soubor úplně 
(soubor je smazán a vytvořen nový s těmito parametry): 
 

 
 

Vysílání 
Data ze všech parametrizačních oken jsou vyslány do zařízení pomocí následujícího potvrzení a dialog 
je uzavřen. 
  

Zrušení (Cancel) 
Dialogové okno je zavřeno bez jakýchkoliv změn v zařízení. Pokud chcete první uložit data , klikněte 
na Save Device Parameter nebo na pole Transmit. 
 
 
Poznámka: Jakmile jste změnili alespoň jeden parametr v Parameterize dialog stav byl změněn na 
hodnotu not saved/transmitted (neuložen/nevyslán). Pokud jste zvolili tlačítko Cancel 
v parametrizačním dialogu zahodili jste provedené změny (s příjmutím bezpečnostní zprávy, kterou 
můžete deaktivovat a pokud je potřeba aktivovat v General Settings – Presentation). Parameterizační 
okno obsahuje následující stránky: Basic Settings, Access Permission a Programs. 
Zněny, které jste udělali budou provedeny pouze pokud kliknete na tlačítko Transmit  v 
Parameterizačním dialogu nebo pokud změny provedete stisknutím tlačítka Save Device Parameter. 
 
Mějte na paměti, že jsou ukládána nebo vysálána pouze data  parametrizační dialogu (a né parametry 
programů 0 – 7!).
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Přístupová práva (Access Permission) 
[Parameterize (New, from File, online) – Access Permission] 
 

 
 

Přiřazení hesla (Password Assignment) 
Zde můžete přiřadit heslo pro mastera a pro uživatele. Vloženy mohou být pouze číselné hodnoty 
s maximální délkou 4 znaků. 
Z bezpečnostních důvodů  po potvrzení hesla budete požádáni o opětovné zapsání hesla. 

 
 
Z bezpečnostních důvodů je napsané heslo zobrazeno hvězdičkami. Uvědomte si, že hesla zde 
vložená jsou hesla připojeného přístroje DIGIFORCE 9310 a nejedná se o hesla k programu 
DigiControl 9310! 
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Ochrana (Protection) 
Pro zapnutí ochrany (dotazu na heslo) musí být zaškrtávátko nastaveno na hodnotu Activated.  
Pokud heslo nepožadujete odstraňte křížek z položky Activated.  
 

Přístupová práva pro uživatele (Access Level for ‘User‘) 
Použijte tohoto výběru pro určení, které možnosti budou chráněny před změnou. 
Pro bližší informace o možnostech nastavení si přečtěte manuál k přístroji. 
 
Mějte na paměti, že minimálně jeden přístup musí být povolen! 
 
 

Uložení parametrů zařízení (Save Device Parameter) 
Data ze všech parametrizačních oken mohou být uložena v záložním souboru. Pokud soubor už 
existuje, můžete přidat parametry do souboru ‘Supplement’ nebo nahradit ‘Replace’ soubor úplně 
(soubor je smazán a vytvořen nový s těmito parametry): 
 

 
 

Vysílání 
Data ze všech parametrizačních oken jsou vyslány do zařízení pomocí následujícího potvrzení a dialog 
je uzavřen. 
  

Zrušení (Cancel) 
Dialogové okno je zavřeno bez jakýchkoliv změn v zařízení. Pokud chcete první uložit data , klikněte 
na Save Device Parameter nebo na pole Transmit. 
 
 
Poznámka: Jakmile jste změnili alespoň jeden parametr v Parameterize dialog stav byl změněn na 
hodnotu not saved/transmitted (neuložen/nevyslán). Pokud jste zvolili tlačítko Cancel 
v parametrizačním dialogu zahodili jste provedené změny (s příjmutím bezpečnostní zprávy, kterou 
můžete deaktivovat a pokud je potřeba aktivovat v General Settings – Presentation). Parameterizační 
okno obsahuje následující stránky: Basic Settings, Access Permission a Programs. 
Zněny, které jste udělali budou provedeny pouze pokud kliknete na tlačítko Transmit  v 
Parameterizačním dialogu nebo pokud změny provedete stisknutím tlačítka Save Device Parameter. 
 
Mějte na paměti, že jsou ukládána nebo vysálána pouze data  parametrizační dialogu (a né parametry 
programů 0 – 7!). 
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Programy (Programs) 
[Parameterize (New, from File, online) -> Programs] 
 

 
 

Aktivní program (Active Program) 
Zobrazené číslo odpovídá aktivnímu programu v DIGIFORCE 9310, když je okno uloženo. Pokud 
chcete aktivovat jiný měřící program vložte do pole požadované číslo (0 – 7). 
  

Programy (Programs) 
Pro nastavení měřícího programu vyberte požadované tlačítko s číslem programu. Při připojeném 
přístroji DIGIFORCE 9310 jsou parametry zobrazené v programu DigiControl 9310 nahrány 
z přístroje.  
 

Kopírování programů 
Pokud chcete zkopírovat měřící program, klikněte na tlačítko programu, který chcete kopírovat a při 
stálém držení tlačítka myši posuňte kurzor na tlačítko programu, do kterého má být program 
zkopírován. 
Tato možnost je dostupná pouze při parametrizaci přístroje, který je připojen (online).  
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Uložení parametrů zařízení (Save Device Parameter) 
Data ze všech parametrizačních oken mohou být uložena v záložním souboru. Pokud soubor už 
existuje, můžete přidat parametry do souboru ‘Supplement’ nebo nahradit ‘Replace’ soubor úplně 
(soubor je smazán a vytvořen nový s těmito parametry): 
 

 
 

Vysílání 
Data ze všech parametrizačních oken jsou vyslány do zařízení pomocí následujícího potvrzení a dialog 
je uzavřen. 
  

Zrušení (Cancel) 
Dialogové okno je zavřeno bez jakýchkoliv změn v zařízení. Pokud chcete první uložit data , klikněte 
na Save Device Parameter nebo na pole Transmit. 
 
 
Poznámka: Jakmile jste změnili alespoň jeden parametr v Parameterize dialog stav byl změněn na 
hodnotu not saved/transmitted (neuložen/nevyslán). Pokud jste zvolili tlačítko Cancel 
v parametrizačním dialogu zahodili jste provedené změny (s příjmutím bezpečnostní zprávy, kterou 
můžete deaktivovat a pokud je potřeba aktivovat v General Settings – Presentation). Parameterizační 
okno obsahuje následující stránky: Basic Settings, Access Permission a Programs. 
Zněny, které jste udělali budou provedeny pouze pokud kliknete na tlačítko Transmit  v 
Parameterizačním dialogu nebo pokud změny provedete stisknutím tlačítka Save Device Parameter. 
 
Mějte na paměti, že jsou ukládána nebo vysálána pouze data  parametrizační dialogu (a né parametry 
programů 0 – 7!).
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Uložení parametrů přístroje                   
(Save Device Parameters) 
 
Pro uložení změněných parametrů přístroje DIGIFORCE do souboru vložte jedinečné jméno pro 
soubor do položky název souboru. Soubory jsou ukládány v textovém režimu proto je možné je 
prohlížet pomocí textového editoru. 
 
Nastavení přístroje je vždy ukládáno do složky Param., která je podložkou složky programu 
(DigiContol 9310). Máte možnost změnit složku i název souboru. 
 

Soubor je uložen do vybrané složky po kliknutí na tlačítko  (složka se vybere po 
kliknutí společně s názvem souboru). 
 
Důležitá poznámka: Pokud změníte parametry ze záložního souboru (Backup-File) nebo uložíte 
některé parametry do záložního souboru (Backup-File), digitální podpis (Digital Signature) záložního 
souboru (Backup File) bude pravděpodobně neplatný! 
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Parametry zařízení (Device Parameters) 
 
 

Základní nastavení – měřící programy (Basic Settings – Measurement 
Programs) 
Parametry přístroje se odkazují na nastavení přístroje DIGIFORCE 9310. 
 
Nastavení přístroje může být rozděleno do základního nastavení (General settings), které je zobrazeno 
v dialogovém okně Parametrize, a měřících programů (dialogové okno Programs 0-7). 
 
Oba typy parametrů přístroje jsou vytvářeny a zpracovávány samostatně. Programy jsou nastavovány 
nezávisle na sobě navzájem (programy 0-7). 
  

Uložení – načtení (Download – Upload) 
Všechny nastavení přístroje DIGIFORCE 9310 jsou uloženy do záložního souboru pokud ukládáte 
nastavení (DIGIFORCE 9310 -> Backup File). 
Pokud načítáte, všechny parametry ze záložního souboru jsou nahrány do přístroje DIGIFORCE 9310. 
 

Vytvořit parametry z továrního nastavení (Create New Device Parameters) 

Můžete vytvořit nové parametry bez připojení přístroje pomocí kliknutí na ikonku   v hlavním 
okně programu nebo následující cestou v menu: File –> New….  
Pokud jsou vytvářeny nové parametry, základní nastavení (které odpovídá nastavení nového přístroje) 
je nahráno do každého dialogového okna přístroje a jsou zobrazeny. 
Můžete změnit a uložit tyto parametry nebo je nahrát do přístroje tlačítkem Transmit. 
 

Otevření a uložení parametrů přístroje 

Můžete nahrát parametry bez připojení přístroje pomocí kliknutí na  v hlavním okně programu 
nebo následující cestou v menu: File –> Open….  
 
Pokud je soubor otevřen parametry jsou nahrány do dialogových oken a jejich položek podle 
uloženého souboru. 
 
Můžete změnit a uložit tyto parametry nebo je nahrát do přístroje tlačítkem Transmit. 
 

Parametrizace (Parameterize) 
Pro zpracování parametrů připojeného přístroje vyberte zařízení ze seznamu zařízení (device list) 
a klikněte na tlačítko Parameterize. Následně budou zobrazeny základní parametry. 
Můžete přistupovat k jednotlivým měřícím programům v záložce Programy (Programs). 
Můžete změnit a uložit tyto parametry nebo je nahrát do přístroje tlačítkem Transmit. 
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Programy (Programs) 
[Parameterize Program (New, from File, online)] 
 

 
 
V přístroji máte možnost definovat maximálně 8 měřících programů (0-7) 
Vložte jméno vybraného měřícího programu do pole Program Name. Můžete načíst, upravovat, 
ukládat nebo vysílat jen jeden měřící program ve stejný čas. 
 
Následující záložky jsou zobrazeny v dialogovém okně. 
 

Nastavení kanálů (Channel Settings) 
Nastavení a kalibrace obou měřících kanálů (X a Y) přístroje DIGIFORCE 9310. 
 

Mód měření (Measuring Mode) 
Definice měřícího módu a doprovodných parametrů. 
  

Test snímačů (Sensor Test) 
Ručně vložené nebo naučené referenční body a specifické tolerance pro oba kanály (X a Y). 
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Vyhodnocení (Evaluation) 
Přiřazením až trojice vyhodnocovacích oken s jejich způsobem vyhodnocením a obálkou s možností 
sledování trendu. 
Online měření současné měřené křivky v DIGIFORCE 9310 a optimalizací vyhodnocovacích oken 
a obálky přes grafické rozhraní. 
 
Dále můžete změřené křivky ukládat a následně nahrávat bez připojeného přístroje DIGIFORCE 9310 
a měnit nastavení vyhodnocovacích oken. 
 

Body sepnutí (Switch Points) 
Nastavení obou přepínacích bodů S1 a S2 stejně jako doprovodné parametry (kanály, reference). 
  

Prezentace (Presentation) 
Vypuštění 5 specifických programových menu a redukce hodnot křivky pro výrobní měřící nastavení 
(volitelná verze DigiControl 9310). 
 

Uložení parametrů zařízení (Save Device Parameter) 
Data ze všech parametrizačních oken mohou být uložena v záložním souboru. Pokud soubor už 
existuje, můžete přidat parametry do souboru ‘Supplement’ nebo nahradit ‘Replace’ soubor úplně 
(soubor je smazán a vytvořen nový s těmito parametry): 
 

 
 

Vysílání 
Data ze všech parametrizačních oken jsou vyslány do zařízení pomocí následujícího potvrzení a dialog 
je uzavřen. 
  

Zrušení (Cancel) 
Dialogové okno je zavřeno bez jakýchkoliv změn v zařízení. Pokud chcete první uložit data , klikněte 
na Save Device Parameter nebo na pole Transmit. 
 
 
Poznámka: Jakmile jste změnili alespoň jeden parametr v dialogovém okně Program (nastavení 
kanálů, měřící mód, test snímačů, vyhodnocovací okna a obálka, body přepnutí nebo prezentace) stav 
byl změněn na hodnotu not saved/transmitted (neuložen/nevyslán). Pokud jste zvolili tlačítko Cancel 
v parametrizačním dialogu zahodili jste provedené změny (s příjmutím bezpečnostní zprávy, kterou 
můžete deaktivovat a pokud je potřeba aktivovat v General Settings – Presentation).  
Zněny, které jste udělali v současném programu (0-7)  budou provedeny pouze pokud kliknete na 
tlačítko Transmit  nebo pokud změny provedete stisknutím tlačítka Save Device Parameter. 
 
Mějte na paměti, že jsou ukládána nebo vysálána pouze data  parametrizační dialogu (a ne parametry 
programů 0 – 7!). Ty jsou drženy odděleně od dialogového okna Parametrize.
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Nastavení kanálu X/Y (Channel Settings 
X/Y) 
[Parameterize Program (New, from File, online) -> Channel Settings] 
 

 
 

Typ senzoru pro kanál X (Sensor Type Channel X) 
Vyberte typ senzoru (Standard Signal nebo Poti)použitého pro kanál X. 
 

Vstupní rozsah kanálu X (Input Range Channel X) 
Pokud byl vybrán Standard Signal potřebujete vybrat vstupní rozsah (Input Range) (5 V nebo 10 V) 
pro kanál X. 
 

Typ senzoru pro kanál Y (Sensor Type Channel Y) 
Vyberte typ senzoru (Standard Signal 5V nebo tenzometr - Strain Gage) použitý pro kanál Y. 
 

Vybuzení kanálu Y (Excitation Channel Y) 
Pokud je vybrán tenzometr (Strain Gage) potřebujete zvolit hodnotu vybuzení snímače (2.5 V nebo 
5 V). 
 

Vstupní rozsah kanálu Y (Input Range Channel Y) 
Pro Piezo snímač může být vybrán vstupní rozsah (Input Range) mezi 1 nC – 400 nC pro kanál Y. 
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El. Level 
Tento parametr pro Piezo snímač spojuje horní kalibrační hodnotu (Upper Calibration Value) 
a vstupní rozsah (Input Range). Tato hodnota je pouze jednoduše vypočtena a zaokrouhlena, proto je 
možné, že se nepatrně liší od hodnoty snímače. 

  
Vybrané jednotky pro kanál X/Y (Selected Unit X/Y) 
Máte na výběr mezi nastavenými jednotkami a uživatelsky nastavitelnou jednotkou pro každý kanál 
samostatně.  
Vložte uživatelsky zadanou jednotku do kolonky User def. Unit X/Y. Nicméně tato jednotka musí být 
aktivní nebo vybrána v položce Vybraná jednotka (Selected Unit)! To odpovídá první položce ze 
seznamu. 
 

Uživatelsky definované jednotky pro X/Y (User def. Unit X/Y) 
Odděleně pro každý kanál vložte uživatelsky definovanou jednotku (user-defined unit), která pak 
může být vybrána přes položku vybraná jednotka X/Y (Selected Unit X/Y). 
 

Nominální rozsah snímače (Nominal Range Channel Y) 
Pokud je vybrán tenzometr (Strain Gage) můžete zde vložit nominální rozsah snímače (Nominal 
Range). Tuto hodnotu naleznete v technické dokumentaci snímače. Mějte na vědomí, že nominální 
rozsah (Nominal Range) musí být větší nebo roven použitému rozsahu (Used Range)! 
 

Použitý rozsah kanálu Y (Used Range Channel Y) 
Pokud je vybrán tenzometr (Strain Gage), může zde být vložen použitý rozsah. Jde o rozsah, který 
bude využíván při měření. Mějte na vědomí, že nominální rozsah (Nominal Range) musí být větší 
nebo roven použitému rozsahu (Used Range)! 
 

Inverze kanálu X/Y (Invert Channel X/Y) 
DIGIFORCE 9310 může vyhodnocovat jen kladné hodnoty X a Y. V některých případech se může stát 
že kanál X nebo Y je v negativních číslech. Aktivaci funkce inverze (Invert) je zamýšlená pro tyto 
případy. Musí být používána s opatrností! 
Pokud je funkce inverze (Invert) aktivní měřené hodnoty příslušného kanálu jsou invertovány.  

 
Filtrace kanálu X/Y (Filter Channel X/Y) 
Definice filtru vnitřního softwaru přístroje DIGIFORCE 9310. Jedná se o oddělený výběr, lomové 
frekvence dolno propustního filtru mezi hodnotami 5 Hz až 400 Hz, nebo deaktivaci pro každý kanál 
samostatně. 
 

Dolní/Horní mez stupnice X/Y (Lower/Upper Scale Value X/Y) 
Definice dolní a horní hodnoty stupnice (Scale Values) pro kanály X a Y založené na použití snímače. 
Mějte na vědomí, že dolní hodnota stupnice musí být nižší než horní hodnota stupnice! 
Poznámka: Dolní kalibrační hodnota (Lower Calibration Value) odpovídá hodnotě snímače při dolní 
mezi stupnice (Lower Scale Value) a horní kalibrační hodnota (Upper Calibration Value ) odpovídá 
horní mezi stupnice (Upper Scale Value). (Jde o dvoubodovou kalibraci). 
 

Kalibra ční hodnota v Dolní/Horní mezi X/Y            
(Lower / Upper Calibration Value X/Y) 
Vložte kalibrační hodnotu kolonky pokud je známá. Pokud chcete uložit hodnotu ze snímače, tak je to 
možné pomocí tlačítka Teach-in. Snímač musí být v zamýšlené poloze.  
Mějte na vědomí, že dolní mezi stupnice (Lower Scale Value) musí být větší menší než horní 
kalibrační hodnota (Upper Calibration Value )! 
Poznámka: Dolní kalibrační hodnota (Lower Calibration Value) odpovídá hodnotě snímače při dolní 
mezi stupnice (Lower Scale Value) a horní kalibrační hodnota (Upper Calibration Value ) odpovídá 
horní mezi stupnice (Upper Scale Value). (Jde o dvoubodovou kalibraci). 
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Načtení/naučení hodnoty v X/Y (Teach-In X/Y) 
Pokud nastavujete online parametry pro DIGIFORCE 9310 můžete naučit kalibrační hodnoty (Lower 
X, Upper X, Lower Y a Upper Y). 
Nově naučené hodnoty jsou v poli zobrazeny po načtení hodnoty ze snímače. Tyto hodnoty jsou 
poprvé poslány do přístroje po kliknutí na tlačítko Transmit nebo jsou uloženy do záložního souboru 
po zmáčknutí na tlačítko Save Device Parameter.  
 
Jen pro piezo verzi DIGIFORCE 9310: Pokud chcete naučit horní kalibrační hodnotu s piezo 
snímačem musíte nejprve naučit dolní kalibrační hodnotu. Tímto krokem nábojový zesilovač bude 
vybit v krátkém čase. 
Pouze po naučení nižší kalibrační hodnoty je možné naučit horní kalibrační hodnotu. 
 

Uložení parametrů zařízení (Save Device Parameter) 
Data ze všech parametrizačních oken mohou být uložena v záložním souboru. Pokud soubor už 
existuje, můžete přidat parametry do souboru ‘Supplement’ nebo nahradit ‘Replace’ soubor úplně 
(soubor je smazán a vytvořen nový s těmito parametry): 
 

 
 

Vysílání 
Data ze všech parametrizačních oken jsou vyslány do zařízení pomocí následujícího potvrzení a dialog 
je uzavřen. 
  

Zrušení (Cancel) 
Dialogové okno je zavřeno bez jakýchkoliv změn v zařízení. Pokud chcete první uložit data , klikněte 
na Save Device Parameter nebo na pole Transmit. 
 
 
Poznámka: Jakmile jste změnili alespoň jeden parametr v dialogovém okně Program (nastavení 
kanálů, měřící mód, test snímačů, vyhodnocovací okna a obálka, body přepnutí nebo prezentace) stav 
byl změněn na hodnotu not saved/transmitted (neuložen/nevyslán). Pokud jste zvolili tlačítko Cancel 
v parametrizačním dialogu zahodili jste provedené změny (s příjmutím bezpečnostní zprávy, kterou 
můžete deaktivovat a pokud je potřeba aktivovat v General Settings – Presentation).  
Zněny, které jste udělali v současném programu (0-7)  budou provedeny pouze pokud kliknete na 
tlačítko Transmit  nebo pokud změny provedete stisknutím tlačítka Save Device Parameter. 
 
Mějte na paměti, že jsou ukládána nebo vysálána pouze data programu. Tyto parametry jsou oddělené  
od dialogového okna Parametrize.
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Prezentace (Presentation) 
[Parameterize Program (New, from File, online) -> Presentation] 
 

 
 

Povolení módů displeje (Release Display Modes) 
Můžete povolit nebo zakázat jednotlivé módy zobrazení změřených dat, které přístroj DIGIFORCE 
9310 nabízí. To může být provedeno příslušnými zaškrtávátkami. 
Poznámka: Mějte na paměti, že minimálně jeden mód musí být aktivní. Pokud se odškrtává poslední 
aktivní mód automaticky se zaškrtne mód 4 jako aktivní. 
 

Redukce hodnot křivek (Reduction of the Curve Values) 
S pomocí tohoto nastavení můžete zmenšit počet bodů křivky v měřícím módu, které budou poslány 
do programu. Pokud je tato funkce aktivní je každý X-tý měřený pár hodnot je poslán zařízením do 
programu DigiControl. Z důvodu přenosového času může být měření optimalizováno pro dosažení 
kratšího produkčního cyklu. 
Mějte na vědomí, že nemusí být možné zobrazit významné body křivky (jako například body, které se 
vymykají vymezení oken). 
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Uložení parametrů zařízení (Save Device Parameter) 
Data ze všech parametrizačních oken mohou být uložena v záložním souboru. Pokud soubor už 
existuje, můžete přidat parametry do souboru ‘Supplement’ nebo nahradit ‘Replace’ soubor úplně 
(soubor je smazán a vytvořen nový s těmito parametry): 
 

 
 

Vysílání 
Data ze všech parametrizačních oken jsou vyslány do zařízení pomocí následujícího potvrzení a dialog 
je uzavřen. 
  

Zrušení (Cancel) 
Dialogové okno je zavřeno bez jakýchkoliv změn v zařízení. Pokud chcete první uložit data , klikněte 
na Save Device Parameter nebo na pole Transmit. 
 
 
Poznámka: Jakmile jste změnili alespoň jeden parametr v dialogovém okně Program (nastavení 
kanálů, měřící mód, test snímačů, vyhodnocovací okna a obálka, body přepnutí nebo prezentace) stav 
byl změněn na hodnotu not saved/transmitted (neuložen/nevyslán). Pokud jste zvolili tlačítko Cancel 
v parametrizačním dialogu zahodili jste provedené změny (s příjmutím bezpečnostní zprávy, kterou 
můžete deaktivovat a pokud je potřeba aktivovat v General Settings – Presentation).  
Zněny, které jste udělali v současném programu (0-7)  budou provedeny pouze pokud kliknete na 
tlačítko Transmit  nebo pokud změny provedete stisknutím tlačítka Save Device Parameter. 
 
Mějte na paměti, že jsou ukládána nebo vysálána pouze data programu. Tyto parametry jsou oddělené  
od dialogového okna Parametrize.
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Test snímačů (Sensor Test) 
[Parameterize Program (New, from File, online) -> Sensor test] 
 
Tato funkce je dostupná pro přístroj DIGICONTROL 9310 ve verzi firmwaru 200208 a vyšší! 
 

 
 
Máte na výběr vložení Referenčního bodu (Reference Point) stejně jako jeho tolerance (Tolerance 
Point) pro hodnoty kanálu X a Y.  
Referenční body mohou být také naučeny pomocí funkce tlach-in u připojeného přístroje.  

 
Hodnota referenčního bodu (Reference Point Value) 
Vložte hodnotu do políčka 
 

Načtení/Naučení (Teach-In) 
Naučit Referenční bod (Reference Point Value) pro připojené zařízení samostatně pro kanál X a Y.  
Poznámka: Mějte na vědomí, že hodnota je uložena v DIGIFORCE 9310. Předchozí hodnota zůstává 
v přístroji DIGIFORCE 9310. Nově naučená hodnota se do přístroje uloží po stisku tlačítka Transmit. 
 

Hodnota tolerančního bodu (Tolerance Point Value) 
Můžete vložit toleranci (+ / -) pro Referenční bod (Reference Point) kanálu X a Y. 
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Uložení parametrů zařízení (Save Device Parameter) 
Data ze všech parametrizačních oken mohou být uložena v záložním souboru. Pokud soubor už 
existuje, můžete přidat parametry do souboru ‘Supplement’ nebo nahradit ‘Replace’ soubor úplně 
(soubor je smazán a vytvořen nový s těmito parametry): 
 

 
 

Vysílání 
Data ze všech parametrizačních oken jsou vyslány do zařízení pomocí následujícího potvrzení a dialog 
je uzavřen. 
  

Zrušení (Cancel) 
Dialogové okno je zavřeno bez jakýchkoliv změn v zařízení. Pokud chcete první uložit data , klikněte 
na Save Device Parameter nebo na pole Transmit. 
 
 
Poznámka: Jakmile jste změnili alespoň jeden parametr v dialogovém okně Program (nastavení 
kanálů, měřící mód, test snímačů, vyhodnocovací okna a obálka, body přepnutí nebo prezentace) stav 
byl změněn na hodnotu not saved/transmitted (neuložen/nevyslán). Pokud jste zvolili tlačítko Cancel 
v parametrizačním dialogu zahodili jste provedené změny (s příjmutím bezpečnostní zprávy, kterou 
můžete deaktivovat a pokud je potřeba aktivovat v General Settings – Presentation).  
Zněny, které jste udělali v současném programu (0-7)  budou provedeny pouze pokud kliknete na 
tlačítko Transmit  nebo pokud změny provedete stisknutím tlačítka Save Device Parameter. 
 
Mějte na paměti, že jsou ukládána nebo vysálána pouze data programu. Tyto parametry jsou oddělené  
od dialogového okna Parametrize.
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Módy měření (Measuring Mode) 
[Parameterize Program (New, from File, online) -> Measuring Mode] 
 

 
 

Funkce (Function) 
Vyberte ze seznamu funkcí. Mějte na vědomí, že některé parametry jsou nastavitelné pouze pro 
některé funkce. Z tohoto důvodu mohou být deaktivovány nebo resetovány. 
  

Rychlost vzorkování (Sample Rate) 
Rychlost vzorkování (Sample Rate) může být nastavena mezi hodnotami 0,000 a 1000,0 pro každou 
funkci Function y=f(x). 
Pokud jsou vybrány funkce y=f(t) nebo y=f(x,t) hodnota musí být mezi 0,2 a 500,0 (jde o čas v ms). 
Pokud hodnota nezapadá do mezí bude při přepnutí funkce hodnota resetována! 
 

Reference (Reference) 
Můžete zvolit mezi: Absolute, Trigger, Final Force a Block Window. 
Absolute při nahrávání se využívá nezměněná změřená hodnota. 
Trigger (Y-Trigger) znamená, že hodnota X je nastavena na 0, když kanál Y dosáhne zadané hodnoty. 
Final Force (konečná síla) znamená, že hodnota X bude nastavena na 0 po dosažení posledního 
změřeného bodu. 
Block Window znamená, že hodnota X je nastavena na 0 při Y-min za hranice okna typu Block 
(i když je mimo vymezenou oblast okna Block). 
Výběr reference má také vliv na ostatní parametry programu. Například hodnota Trigger  může být 
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nastavena pouze, když je také Trigger nastavena jako reference.  
 

Spoušť (Trigger) 
Nastavení spouště (trigger) má význam pouze pokud je Trigger nastavena jako reference. Jinak nemá 
nastavení význam. 
 

Ukaž po (Show Until) 
Při aktivním nastavení X-Max display zobrazí maximální hodnotu X s maximální hodnotou Y ve 
stejný čas, pokud je X konstantní v této oblasti. 
To stejné platí pro nastavení Y-Max. Maximální Y je zobrazeno s maximálním X ve stejný čas, pokud 
je Z konstantní v této oblasti. 
 

Nulování pomocí PLC (PLC Tare) 
Specifikace četnosti funkce PLC Tare. Můžete vybrat možnost ze seznamu.  

 
Nastavení startovací podmínky (Start Mode) 
Můžete zvolit mezi vnitřním (internal) startem a vnějším (external) startem. Pro vnitřní start musí být 
definovány hodnoty v kolonkách Start a Stop.  
 

Start 
Vložte číselnou hodnotu od, které by mělo začít měření. Toto je možné pouze pokud je vybrán vnitřní 
start (internal start)! 
  

Stop 
Vložte číselnou hodnotu od, které vy se mělo měření zastavit. Toto je možné pouze pokud je vybrán 
vnitřní start (internal start)! 
Pokud této hodnoty není dosaženo, měření pokračuje do doby, kdy hodnota klesne pod úroveň start.  
 

Uložení parametrů zařízení (Save Device Parameter) 
Data ze všech parametrizačních oken mohou být uložena v záložním souboru. Pokud soubor už 
existuje, můžete přidat parametry do souboru ‘Supplement’ nebo nahradit ‘Replace’ soubor úplně 
(soubor je smazán a vytvořen nový s těmito parametry): 
 

 
 

Vysílání 
Data ze všech parametrizačních oken jsou vyslány do zařízení pomocí následujícího potvrzení a dialog 
je uzavřen. 
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Zrušení (Cancel) 
Dialogové okno je zavřeno bez jakýchkoliv změn v zařízení. Pokud chcete první uložit data , klikněte 
na Save Device Parameter nebo na pole Transmit. 
 
 
Poznámka: Jakmile jste změnili alespoň jeden parametr v dialogovém okně Program (nastavení 
kanálů, měřící mód, test snímačů, vyhodnocovací okna a obálka, body přepnutí nebo prezentace) stav 
byl změněn na hodnotu not saved/transmitted (neuložen/nevyslán). Pokud jste zvolili tlačítko Cancel 
v parametrizačním dialogu zahodili jste provedené změny (s příjmutím bezpečnostní zprávy, kterou 
můžete deaktivovat a pokud je potřeba aktivovat v General Settings – Presentation).  
Zněny, které jste udělali v současném programu (0-7)  budou provedeny pouze pokud kliknete na 
tlačítko Transmit  nebo pokud změny provedete stisknutím tlačítka Save Device Parameter. 
 
Mějte na paměti, že jsou ukládána nebo vysálána pouze data programu. Tyto parametry jsou oddělené  
od dialogového okna Parametrize. 
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Body sepnutí (Switch Points) 
[Parameterize Program (New, from File, online) -> Switch Points] 
 

 
 

Body sepnutí S1 a S2 (Switch Points S1 and S2) 
Máte možnost definovat body sepnutí příslušných výstupních signálů na PLC. 
 

Hodnota (Value) 
Vložte číselnou hodnotu, která musí být překročena na kanálu X nebo Y, aby došlo ke změně 
logického signálu. Signál zůstává aktivní do doby dokud neklesne hodnota pod nastavenou mez.  
 

Kanál (Channel) 
Vyberte požadovaný měřící kanál (X nebo Y), kterému bude přiřazeno spínání výstupních signálů.  

 
Reference 
Pokud je spínací signál přiřazen kanálu X, musí být pro tento signál nastavena reference. Toto je 
spojeno s absolute (calibrated) zero point nebo the trigger zero point.  
Pokud je aktivní Reference Trigger, Switch Points reagují pouze po překročení startovací podmínky! 
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Uložení parametrů zařízení (Save Device Parameter) 
Data ze všech parametrizačních oken mohou být uložena v záložním souboru. Pokud soubor už 
existuje, můžete přidat parametry do souboru ‘Supplement’ nebo nahradit ‘Replace’ soubor úplně 
(soubor je smazán a vytvořen nový s těmito parametry): 
 

 
 

Vysílání 
Data ze všech parametrizačních oken jsou vyslány do zařízení pomocí následujícího potvrzení a dialog 
je uzavřen. 
  

Zrušení (Cancel) 
Dialogové okno je zavřeno bez jakýchkoliv změn v zařízení. Pokud chcete první uložit data , klikněte 
na Save Device Parameter nebo na pole Transmit. 
 
 
Poznámka: Jakmile jste změnili alespoň jeden parametr v dialogovém okně Program (nastavení 
kanálů, měřící mód, test snímačů, vyhodnocovací okna a obálka, body přepnutí nebo prezentace) stav 
byl změněn na hodnotu not saved/transmitted (neuložen/nevyslán). Pokud jste zvolili tlačítko Cancel 
v parametrizačním dialogu zahodili jste provedené změny (s příjmutím bezpečnostní zprávy, kterou 
můžete deaktivovat a pokud je potřeba aktivovat v General Settings – Presentation).  
Zněny, které jste udělali v současném programu (0-7)  budou provedeny pouze pokud kliknete na 
tlačítko Transmit  nebo pokud změny provedete stisknutím tlačítka Save Device Parameter. 
 
Mějte na paměti, že jsou ukládána nebo vysálána pouze data programu. Tyto parametry jsou oddělené  
od dialogového okna Parametrize. 
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Vyhodnocení (Evaluation) 
[Parameterize Program (New, from File, online) -> Evaluation] 
 

 
 

Měřící křivky (Measurement Curves) 
Měření (Measure) 
Pokud stisknete tlačítko Measure objeví se dialog Measure (pole naučených křivek - Teach-in Array 
of Curves). Zde můžete provádět měření se zařízením a změřené křivky budou zobrazeny graficky 
a také jejich seznam. 
Změřené křivky jsou samostatně označitelné. Vybraná křivka je zobrazena zelenou barvou. Některé 
křivky nemusí být vybrány, mohou být deaktivovány. 
V měřícím módu můžete vidět číslo měření. 
Můžete změnit číslo měřené křivky v General Settings – Presentation. 
 
Poznámka: Pole změřených křivek je užitečné pro nastavování vyhodnocovacích oken a obálky. 
Seznam souboru křivek a měřících programů jsou uloženy odděleně, ale ve většině případů dávají 
smysl pouze společně. 
Změny vyhodnocovacích oken nebo obálky jsou principiálně efektivní k vyhodnocení výsledku 
pokud jsou poslány do zařízení. 
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Načítání/Ukládání (Load / Save) 
Je možné uložit pole křivek, pokud byly naučeny během měření. Soubor křivek můžete načíst kdykoli. 
  
Mějte na vědomí, že velikost souboru se zvyšuje, pokud je nahráno několik křivek! 
 
Z důvodů systémových nároků načítání a ukládání pole křivek pod Windows 95/98/Me/NT4.0 trvá 
déle než Windows 2000/XP. 
 
Smazání (Delete) 
Zmáčkněte tlačítko Delete pro smazání všech změřených křivek ze seznamu. 

 
Tisk pole křivek (Curve Array Print-out) 
Pokud chcete vytisknout zobrazené křivky stiskněte tlačítko Curve Array Print-out. Objeví se 
běžné okno pro tisk. 
 
Aktivní (Active) 
V měřícím seznamu můžete najít položku Aktive. Jen křivky, které jsou označeny jako aktivní 
jsou použity pro následující funkce: 
- Uložit (Save) 
- Tisk pole křivek (Curve Array Pint-out...) 
- Nová obálka (Envelope New...) 

 

Vyhodnocovací okna (Windows) 
Před přiřazením typu okna by mělo být rozhodnuto, které číslo bude využito. K tomuto slouží záložky 
(Window 1 – Window 3).  
Pokud už bylo okno definováno všechny odpovídající hodnoty jsou zobrazeny a okna je v grafu 
zobrazena modře. 
Následující nastavení se týká vždy čísla odpovídajícího aktivní záložce. 
 

Typ (Type) 
Můžete vybrat z následujících typů okna (v závorce písmena pro anglickou verzi): 
• Pass (průchozí) (P) 
• Online  (O) 
• Block (neprůchozí) (B) 
 
Pokud je vybrán typ okna, startovací hodnoty jsou zobrazeny v dolní části grafu. 
Pro deaktivování okna musíte v typu okna vybrat položku ”Off” . Jinak byl typ definován pro toto 
okno. 
Je možné určit specifické vlastnosti pro vyhodnocovací okno (souřadnice okna, místo vstupu 
a výstupu z okna). Okno je považováno za splněné (OK) pouze, pokud jsou při měření naplněny 
všechny podmínky. Pokud je jedna podmínka nesplněna okno je vyhodnoceno jako nesplněné (NOK). 
 

Vstup (Entry) 
Vyberte, kterou stranou má křivka do okna vstupovat. 
Pokud aktuální vstupní strana nezapadá do změřených hodnot je okno vyhodnoceno jako nesplněné 
(NOK). 
Vstup může být přiřazen pouze pro okna typu průchozí (pass) a block. Okno typu online má pevnou 
definici.  
 

Výstup (Exit) 
Vyberte, kterou stranou má křivka z okna vystupovat. 
Pokud aktuální výstupní strana nezapadá do změřených hodnot je okno vyhodnoceno jako nesplněné 
(NOK). 
Výstup může být přiřazen pouze pro okno typu průchozí (pass). Pro okno typu online je napevno 
nastaven výstup z pravé strany a pro okno typu Block není výstup povolen. 



Operační  manuál                                                    PC-Software  DigiControl 9310                                                        Strana 45 z 121   

Souřadnice (Coordinates) 
Pro vložení přesných souřadnic oken jednoduše vyplňte odpovídající hodnoty Xmin, Xmax, Ymin 
a Max. Změna grafického znárodnění okna proběhne po zmáčknutí klávesy Ester nebo po vstupu do 
dalšího pole. 
 
Poznámky:  
- Pokud je maximální hodnota menší než minimální jsou hodnoty po potvrzení automaticky 
prohozeny! 
- Pokud hodnoty okna nezapadají do zobrazeného grafu je možné, že okno bude vidět pouze z části 
nebo nebude vidět vůbec. V tomto případě zmáčkněte na tlačítko Auto pro překreslení grafu. 
 

Kreslení, pohybování s okny (Draw, move Windows…) 
Můžete kreslit vyhodnocovací okna přímo v grafu. 
Můžete provádět následující funkce přímo s využitím myši: 
Posun vyhodnocovacího okna: 
Klikněte na aktivní okno (modré) a myší přesuňte okno do požadované pozice. 
Změna velikost vyhodnocovacího okna: 
Klikněte na aktivní okno (modré) a najeďte myší na zvýrazněný bod, kurzor myši se změní na šipečku. 
Zmáčkněte levé tlačítko myši a posuňte vybraný bod pohybem myši. 
Nakreslení vyhodnocovacího okna: 
Nakreslení probíhá myší za držení pravého tlačítka myši při vybrání záložky okna. 
Změna měřítka: 
Vyberte myší oblast k přiblížení při současného držení levého tlačítka myši a klávesy CTRL. 
 

Obálka (Envelope) 
Pokud byl načten nebo přečten ze zařízení měřící program s obálkou, můžete vidět nastavení obálky. 
Pro změnu těchto nastavení klikněte na tlačítko Change. Následně se zobrazí možnost změny obálky. 
 
K vytvoření nové obálky potřebujete pole změřených křivek, které je možné získat pomocí učení 
(Teach-in v Measure) nebo pomocí načtení křivek ze souboru. 
 
 
Pomocí nastavení Show Envelope Curves a Show Trend Curves můžete zobrazit existující křivky 
graficky. 
Ale v reálné situaci je obálka (On/Off) nezávislá na tomto nastavení! 
 
Pro nastavení grafického nastavení obálky otevřete General Settings - Presentation nebo General 
Settings - Colours. 
 
 

Přiblížení (Zoom) 
Měřítko křivky měření je měněno pomocí přiblížení. Máte na výběr ručního (Manual) nebo 
Automatické (Auto).  

Ruční (Manual) 
V módu ručního přiblížení (Manual Zoom) jsou osy reprezentovány hodnotami X-min / X-max /     
Y-min / Y-max.  
 
Automatické (Auto) 
V automatickém nastavení je displej závislý na všech aktivních křivkách, aby byly zobrazeny celé.  
 
X-min / X-max / Y-min / Y-max 
Určuje hodnoty zobrazeného grafu, tyto hodnoty mohou být změněny v ručním režimu přiblížení. 
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Navigace (Navigation) 
Můžete pohybovat grafem křivky pomocí kurzorových šipek (nahoru, dolu, doleva, doprava). 
 
 

Uložení parametrů zařízení (Save Device Parameter) 
Data ze všech parametrizačních oken mohou být uložena v záložním souboru. Pokud soubor už 
existuje, můžete přidat parametry do souboru ‘Supplement’ nebo nahradit ‘Replace’ soubor úplně 
(soubor je smazán a vytvořen nový s těmito parametry): 
 

 
 

Vysílání 
Data ze všech parametrizačních oken jsou vyslány do zařízení pomocí následujícího potvrzení a dialog 
je uzavřen. 
  

Zrušení (Cancel) 
Dialogové okno je zavřeno bez jakýchkoliv změn v zařízení. Pokud chcete první uložit data , klikněte 
na Save Device Parameter nebo na pole Transmit. 
 
 
Poznámka: Jakmile jste změnili alespoň jeden parametr v dialogovém okně Program (nastavení 
kanálů, měřící mód, test snímačů, vyhodnocovací okna a obálka, body přepnutí nebo prezentace) stav 
byl změněn na hodnotu not saved/transmitted (neuložen/nevyslán). Pokud jste zvolili tlačítko Cancel 
v parametrizačním dialogu zahodili jste provedené změny (s příjmutím bezpečnostní zprávy, kterou 
můžete deaktivovat a pokud je potřeba aktivovat v General Settings – Presentation).  
Zněny, které jste udělali v současném programu (0-7)  budou provedeny pouze pokud kliknete na 
tlačítko Transmit  nebo pokud změny provedete stisknutím tlačítka Save Device Parameter. 
 
Mějte na paměti, že jsou ukládána nebo vysálána pouze data programu. Tyto parametry jsou oddělené  
od dialogového okna Parametrize. 
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Průchozí okno (Pass Windows) 
 
Nejvíce používaným oknem je okno průchozí. 
  
Tento typ okna vyžaduje, aby křivka křivka vstoupila do okna požadovanou stranou a vystoupila z něj 
požadovanou stranou bez doteku ostatních hranic okna  
 
V programu mohou být přiřazena maximálně 3 okna typu Pass. 
 
 
 
 
 

Online okno (Online Windows) 
 
Online okno (známé také jako „merge-slučované“) je uřčeno speciálně pro vstřikovací a spárovací 
operace. Kontroluje, zda jsou sloučeny správně a ne nesouose. Při lisování je toto doprovázeno ostrým 
zvýšením síly ve slučované oblasti. Toto následně opustí vrchní stranou okna.  
 
Online okno je schopné kontrolovat pouze pozitivní běh křivky (zleva doprava). 
  
V programu může být přiřazeno maximálně 1 okno typu Online. 
 
 
 
 
 

Blokovací okno (Block Windows) 
 
Okno typu block například monitoruje sílu stlačovaného spojení. Křivka musí vstoupit do  okna 
určenou stranou (Levá-Left, Pravá-Right, Horní-Upper, Dolní-Lower mimo Nezáleží-Don’t care),  
ale nesmí okno opustit! 
Pro splnění podmínky OK křivka nesmí okno opustit – proto výstupní strana z okna není 
specifikována. 
 
V programu může být přiřazeno maximálně 1 okno typu Block. 
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Offline / Online 
 

Offline 
Offline odkazuje na běh nastavování parametrů zařízení ze zálohy nebo z nově vytvořeného souboru 
bez připojení přístroje DIGIFORCE 9310. 
Tyto parametry mohou být následně znovu uloženy jako záložní soubory. Pokud je v seznamu 
připojených zařízení aspoň jedno zařízení mohou být parametry přímo poslány do stanice. 
 
 

Online 
Online odkazuje na to, že jsou parametry čteny přímo z DIGIFORCE 9310. Pro docílení tohoto musíte 
vybrat ze seznamu zařízení stanici a použít kontextové menu (pravým tlačítkem myši) nebo 
zmáčknutím tlačítka Parameterize Pro přečtení parametrů přímo ze stanice. 
Tyto parametry mohou být následně nahrány do stejné stanice nebo uloženy jako záložní soubory. 
Tyto záložní soubory mohou být vloženy do libovolné stanice, kterou vyberete při nahrávání (Upload). 
 
 
 
 

Učení (Teach-In) 
 
Teach-In odkazuje na  ”přizpůsobení” nebo na měření dat. 
Tato funkce může bát použita při online operacích pro nastavení kalibračních hodnost stejně jako 
referenčních bodů (Testu snímačů Sensor Test). 
Následuje zobrazení hodnot, které byly změřeny při učení (Teach-In). 
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Experimentální operace               
(Laboratory Operation) 
[Measure -> Laboratory Operation] 
 

 
 
Do experimentálních operací můžete přistoupit vybráním stanice (pokud je přítomna) ze seznamu 

zařízení. Nyní klikněte na ikonku  nebo následující cestou ‘Measure’ -> ‘Laboratory Operation’. 
 
Můžete přečíst, zobrazit, vytisknout, uložit změřené data jako měření nebo měření exportovat. 
Uložený soubor můžete kdykoli otevřít.  
 

Načíst změřená data (Read Measurement Data) 
Klikněte na tlačítko Read Meas Data Pro načtení dat z přístroje. 
Pokud zařízení neobsahuje žádná změřená data zobrazí se upozorňující oznámení. 
Načítání změřených dat může trvat několik minut pokud nastavení rozhraní není nastavení správně a 
pokud je přenášeno velké množství naměřených bodů. 
Po dobu přenosu se v odpovídající sekci objeví nápis Data Transfer. 
 

Exportovat změřená data (Export Measurement Data) 
Při požadavku na uložení změřených dat z DIGIFORCE 9310, klikněte na tlačítko Export Meas Data. 
Data jsou uloženy ve formátu specifikovaném v General Settings. Pokud je potřeba změňte toto 
nastavení. 
 
Můžete také definovat složku, kde se budou ukládat soubory měření. To je prováděno v General 
Settings (Data Storage).  
Název souboru je kombinací data, času a sériového čísla DIGIFORCE 9310. Touto cestou mohou být 
soubory jasně přiřazeny.  
Samozřejmě máte možnost je před uložením přejmenovat.  
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Uložení (Save) 
Můžete uložit zobrazené měření ve formátu, který je speciální pro program DigiControl 9310. Pro toto 
zmáčkněte tlačítko Save. Pomocí tlačítka Load můžete zobrazit změřená data kdykoliv je potřeba. 
 
Digitální podpis byl vložen do každého uloženého souboru. Digitální podpis dává informace 
o možnosti potenciální změny souboru. 
  
Můžete také definovat složku, kde se budou ukládat soubory měření. To je prováděno v General 
Settings (Data Storage).  
 

Nahrání (Load) 
Pomocí tlačítka Load můžete zobrazit kompletní naměřené data, které byla uložena pomocí tlačítka 
Save. 
 
Můžete také definovat složku, kde se budou ukládat soubory měření. To je prováděno v General 
Settings (Data Storage).  
 

Tisk protokolu (Print Protocol) 
Klikněte na tlačítko Print Protocol pro tisk současného měření do tiskárny vybrané v DigiControl. 
Objeví se okno pro úpravu přídavných informací. 
 
Po potvrzení informací tlačítkem Next se objeví dialog tisku. 
 

Vyhodnocování (Evaluation) 
Po načtení změřených hodnot z přístroje DIGIFORCE 9310, obdržíte oznámení o měření 
(OK/NOK/NIT). Jdou dostupné tři formáty: 

- Smiley:   zelený (OK), červený (NOK), červený (NIT) 
- Text:    OK nebo NOK, NIT (NOK-Trend – nepasující do trendu) 
- Measurement curve:  Barva křivky může být nastavena. 

 

Podpis (Signature) 
Můžete vidět libovolné informace o stavu digitálního podpisu (Digital Signature) Pokud nebyl 
digitální podpis nalezen nebo byl nesprávný (například z důvodu manipulace ze souborem). 
Mějte na vědomí, že digitální podpis je přítomný od verze programu DigiControl 2003.1.0. 
 

Obecné (General) 
Minimální a maximální hodnoty (X/Y) pro současné měření jsou zobrazeny v záložce Curve Data.  
 

Okna (Windows) 
Pokud vyhodnocovací okna byly definovány pro aktuální měřící program, nastavení jsou zobrazeny 
v horní sekci a výsledky v dolní sekci. 
Pokud vyhodnocovací hodnoty neexistují v nastavení objeví se n.a.. 
 

Změřené hodnoty (Meas. Values) 
Jednotlivé body křivky jsou zobrazeny v záložce Meas. Values. 
Můžete na jednotlivé řádky kliknout pro jejich zvýraznění v grafu. Referenční kurzor můžete 
deaktivovat pomoci zmáčknutí pravého tlačítka myši v okně grafu.  
 
Můžete se v seznamu posouvat nahoru a dolů pomocí šipek na klávesnici. Referenční kurzor zvýrazní 
označený řádek. 
 
Pokud si přejete změnit barvu změřené křivky můžete to udělat v General Settings - Presentation 
section. 
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Obálka (Envelope) 
Pokud  současný měřící program obsahuje aktivní obálku (od verze DIGIFORCE Firmware V200304) 
můžete vidět přídavnou záložku obálka (Envelope). Pokud je aktivní sledování trendů (Trend tracking) 
můžete o něm vidět informace. 
  

Přiblížení (Zoom) 
Přibližováním je myšlena změna rozsahu zobrazovaného měření. Můžete přepínat mezi nastavením 
Auto Zoom nebo Manual. 
 
Ruční (Manual) 
Pokud chcete měnit rozsahy zobrazení ručně musíte vybrat Manual a vložit požadované hodnoty do 
kolonek X-min, X-max, Y-min a Y-max.  
 
Automatické přiblížení (Auto Zoom) 
Pokud by měřítko grafu mělo být změněno automaticky při nahrání změřených dat měla by být 
zaškrtnuta možnost Auto Zoom. 
Automatickou změnu měřítka můžete provést stiskem tlačítka Auto Zoom. To je nezávislé na 
nastavení možnostech přiblížení (Manual nebo Auto Zoom) (Poznámka: Při nastavení Manual budou 
nastavené hodnoty ztraceny!). 
 
X-min / X-max / Y-min / Y-max 
Vždy můžete vidět aktuálním nastavení těchto hodnot, Pokud je aktivní ruční změna můžete tyto pole 
ručně měnit.  
 

Kurzory (Cursors) 
Pro měření jsou dostupné dva kurzory: referenční kurzor a poziční kurzor. Tyto dva kurzory můžete 
použít pro měření vzdáleností bodů v měřící křivce. 
Kurzory můžete zapnout nebo vypnout následujícím způsobem: 
Reference cursor (Cursor 1): Kliknutím pravým tlačítkem myši 
Position cursor (Cursor 2): Kliknutím levým tlačítkem myši 
 
Barvu kurzorů můžete změnit v General Settings - Colors. 
 

Zachytit přiblíženou oblast myší (Capture the zoomed area with the mouse) 
Při současného držení klávesy CTRL a levého tlačítka myši vybíráte oblast, která bude po 
puštění levého tlačítka myši roztažena na celou oblast grafu. 
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Tisk protokolu (Print-out Protocol) 
[Measure -> Laboratory Operation -> Print Protocol] 
 
Před tiskem můžete změnit následující data: 
 
- Společnost (Company)  (změnitelná v User Information) 
- Editor (změnitelná v User Information) 
- Popis (Description) (bude uložen pro následující protokol tlačítkem save) 
- poznámka (Remark) (bude uložen pro následující protokol tlačítkem save) 
- tisk obálky společně s křivkou * 
- tisk křivky trendů společně s křivkou * 
 
Pokud stisknete tlačítko Next objeví se dialog konfigurace tiskárny. Tady můžete vybrat: 
- Náhled (Preview) 
- Tisk (Print) 
- Exportovat do PDF (Export to PFD) 
 
 

 
 
* = Dostupné od DIGIFORCE 9310 Firmware V200304 
 
 



Operační  manuál                                                    PC-Software  DigiControl 9310                                                        Strana 53 z 121   

Výběr parametrů pro tisk       
(Selection of parameters for print-out) 
[Edit -> Parameter Print-out -> Load Parameter File -> … -> Print] 
 

 
 
Můžete rozhodnout, které programy (Program Number) si přejete vytisknout, které jste načetli ze 
záložního souboru parametrů. Také můžete vytisknout základní nastavení (Basic Settings). 
 
Pro tisk musíte vybrat tiskárnu v General Settings – Printing. 
 
Pro potvrzení výběru zmáčkněte tlačítko OK. 
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Tisk pole křivek (Curve Array Print-out) 
[Parameterize Program (New, from File, online) -> Evaluation -> Curve Array Print-out] 
 

 
 
Pokud chcete vytisknout pole křivek (Array of Curves), které jste změřili pomocí (Teach-in Array of 
Curves) klikněte na tlačítko Curve Array Print-out ve vyhodnocovacím dialogu. 
 
Nastavení tisku může být definováno v General Settings. 
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Jednoduchý náhled: 
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Náhled tisku (Print Preview) 
 

 
 
Pokud je aktivní okno náhledu pro měřící protokol, nastavení zařízení, statistiky nebo pole křivek je 
možné jej uložit přímo jako soubor náhledu. 
Uložené soubory mají koncovku *.LL a mohou být otevřeny a zobrazeny pouze v programu 
DigiControl 9310 od verze V2004.1.0 . 
Běžně jsou velikosti souborů náhledu mnohem menší než soubory PDF a nemohou být měněny. 
  
Více nastavení v náhledu tisku (More Options at the Print Preview) 
 
Tisk současné stránky (Print current page…) 

Pokud chcete vytisknout současno stránku zmáčkněte na tlačítko  levým tlačítkem myši. 

Pro výběr jiné tiskárny nebo pro změnu nastavení parametrů tiskárny stiskněte tlačítko  pravým 
tlačítkem myši. Objeví se okno nastavení tiskárny. 
 
Tisk všech stránek (Print all pages…) 

Pokud chcete vytisknout všechny dostupné stránky zmáčkněte tlačítko  levým tlačítkem myši. 

Pro výběr jiné tiskárny nebo pro změnu nastavení parametrů tiskárny stiskněte tlačítko  pravým 
tlačítkem myši. Objeví se okno nastavení tiskárny. 
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Uložit jako (Save As…) 
Pokud chcete uložit náhledový soubor nebo jako jiný soubor například PDF nebo grafický soubor 

stiskněte tlačítko . 
 
Poslat e-mailem (e-Mail (Send to…)) 
Pokud chcete poslat náhled jako náhledový soubor, soubor PDF nebo jako grafický soubor pomocí    

e-mailu stiskněte tlačítko . Potom můžete vybrat typ souboru a stisknout tlačítko OK. Systémem 
určený program (pokud je dostupný) se otevře a v příloze bude mít požadovaný soubor. 
  
Opustit náhled (Exit Preview) 

Pro opuštění náhledu zmáčkněte tlačítko . 
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Nahrát soubor do DIGIFORCE        
(Upload (Backup File -> DIGIFORCE)) 
[Mark a Station in the device list -> File -> Upload] 
 
Použijte tuto funkci pro vyslání nastavení přístroje ze souboru zálohy DigiControl  zpět do 
DIGIFORCE 9310. 
 

Funkci můžete zavolat stisknutím tlačítka  v hlavním dialogovém okně nebo vybráním Upload 
(Backup File –> DIGIFORCE) v položce File hlavního menu.  
 
Vyberte soubor zálohy, který chcete poslat do DIGIFORCE 9310. 
Dialogové okno se vždy otevře ve složce DigiControl 9310\Param. Soubor vyberete dvojklikem na 
jméno souboru nebo jednoduchým kliknutím a potvrzením tlačítkem Open pro poslání parametrů ze 
zálohového soubodu do přístroje.  
 
Před začátkem nahrávání zálohy do přístroje budete informováni o stavu digitálního podpisu. 
Mějte na vědomí, že digitální podpis je přítomný od verze 2003.1.0. Jinak dostanete upozornění, že 
nebyl nalezen digitální podpis pro soubory uložené ve starší verzi programu. 
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Stáhnutí nastavení z přístroje       
(Download (DIGIFORCE -> Backup File)) 
[Mark a Station in the device list -> File -> Download] 
 
Záloha obsahuje veškeré nastavení zařízení pro vybraný přístroj DIGIFORCE 9310. 
 

Záloha může být zavolána kliknutím na tlačítko  v hlavním dialogovém okně nebo výběrem 
položky Download (DIGIFORCE -> Backup File) z File main menu.. 
 
Mějte na vědomí, že první musíte vybrat zařízení, ze kterého se má záloha vytvořit. Jinak se objeví 
zpráva o chybě. 
  
Vyberte cestu a jméno záložního souboru přístroje DIGIFORCE 9310. 
 
Dialogové okno se vždy otevře ve složce DigiControl 9310\Param. Do položky Name napište jméno 
a zmáčkněte tlačítko Save.  
 
Digitální podpis byl vložen do souboru zálohy. Dává informaci o možnosti manipulace se souborem. 
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Společné uložení (Common Download)  
uloží nastavení všech přístrojů do oddělených záloh (Download of all DIGIFORCE into 
a separate backup file) 
[File -> Download of all DIGIFORCE into a separate backup file] 
 
Pro společné uložení (Common Download) souborů zálohy pro všechny přístroje zobrazené v listu 
zařízení. 
 
DigiControl zkontroluje všechny zařízení DIGIFORCE v seznamu zařízení před započetím 
zálohování. Musí být zapojeny do sériového rozhraní. 
Pokud některé zařízení není dostupné bude záloha ukončena. 
 
Pokud chcete používat společnou zálohu s jinými zařízeními nejprve proveďte detekci zařízení (device 
Search). 
 
Pro společné uložení budou vytvořeny složky s názvem „Common“.  
Ve složce „Common“ bude provedeno uložení do podložek podle následujícího formátu: 
 
<YYYY_MM_DD[-Index]> 
 
Pokud děláte více než jednu zálohu denně index se automaticky zvýší. 
  
Digitální podpis byl přidán do každého souboru zálohy. Digitální podpis dává informace o možné 
manipulaci se souborem. 
 
 
 
 
 

Společné nahrání (Common Upload)  
nahrání jednoho záložního souboru do všech přístrojů (Upload one backup file into all 
DIGIFORCE) 
[File -> Upload one backup file into all DIGIFORCE] 
 
Se společným nahráním je jeden záložní soubor nahrán do všech připojených zařízení, které jsou 
vypsány v seznamu zařízení. 
  
DigiControl zkontroluje všechny zařízení DIGIFORCE v seznamu zařízení před započetím nahrávání. 
Musí být zapojeny do sériového rozhraní. 
Pokud některé zařízení není dostupné bude nahrávání ukončeno. 
 
Pokud chcete používat společné nahrání s jinými zařízeními nejprve proveďte detekci zařízení (device 
Search). 
 
U společného nahrávání postupujte stejně jako u jednoduchého nahrávání.  
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Základní nastavení (General Settings) 
[Edit -> General Settings] 
 
V dialogovém okně základního nastavení  (General Settings) můžete vybrat z následujících položek.  
Musíte mít příslušné bezpečnostní oprávnění pro změnu libovolných nastavení programu. 
 

Rozhraní (Interfaces) 
Nastavení rozhraní pro určení specifikací rozhraní při komunikaci s DIGIFORCE 9310 
 

Mezinárodní (International) 
Nastavení pro následující parametry: 
• Rozhraní porgramu / jazyk online nápovědy 
• Formátování čísel 
 

Bezpečnost (Security) 
• Heslo 
• Informace o uživateli 
 

Uložení dat (Data Storage) 
Výběr následujících složek: 
• Cesta pro nastavení parametrů 
• Cesta pro soubory měření 
• Cesta pro experimentální protokoly 
• Cesta pro pole křivek 
• Cesta pro statistické parametry 
 

Záloha (Backup) 
Nastavení pro ukládání a nahrávání souborů zálohy. 
 

Výstup (Output) 
Určení formátování měření při exportu souborů. To může být například provedeno v programu Excel.¨ 
  

Tisk (Printing) 
Nastavení možností tisku. 
 

Reprezentace dat (Presentation) 
Nastavení pro grafický displej a měřenou křivku. 
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Mezinárodní (International) 
[Edit -> General Settings -> International] 
 

 
 

Jazyk 
Můžete vybrat jazyk programu (Program Language) stejně jako jazykovou verzi online nápovědy 
(Online-Help Language) v záložce International. 
 
Pro informační účely jsou v položce (Language of the System) zobrazeny data o jazykové verzi 
operačního systému. 
Lokace definuje různorodé systémové specifikace jako je formátování. 
Nastavení můžete zkontrolovat v nabídce Start: Settings -> System Setting -> Country Settings. 
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Čísla (Numbers) 
V položce Number of Decimals je možné vybrat způsob zobrazení čísel. Je zde několik variant 
zobrazených na obrázku. 
 

 
 
Oddělovač desetinného místa (Decimal Separator) ukazuje formátování, které je specifické podle 
systému. 
 
 
Klikněte na tlačítko OK pro převzetí specifikací. 
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Uložení dat (Data Storage) 
[Edit -> General Settings -> Storage] 
 
V tomto dialogovém okně vyberte základní složky pro ukládání parametrů zařízení, měřících 
protokolů, statistických souborů, a polí křivek. 
 

 
 
Máte možnost vybrání složek pro každý typ. 
Pro změnu složky klikněte na tlačítko Change. Objeví se dialogové okno ve, kterém může být složka 
vybrána:  
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Samozřejmě složky mohou být vybrány z jiné jednotky, z jiného počítače nebo na serveru na síti.  
 
Složky stejně jako nastavení ukládání jsou dostupné pro následující typy: 
 

Parametry zařízení (Device Parameter Settings) 
Tato složka obsahuje všechny soubory parametrů zařízení, které můžete generovat offline nebo 
s připojeným zařízením DIGIFORCE 9310. 
 
Následující informace mohou být také specifikovány zde: 
• Všechny programy (také nepojmenované) nebo jen nepojmenované programy(Save unnamed 

programs). 
 
Poznámka: Mějte na vědomí, že čas potřebný pro uložení závisí na této volbě! 
 

Export změřených dat (Measurement Data Export) 
Vytvořené soubory měření jsou uloženy v předdefinované lokaci. Specifikujte formát dat těchto 
souborů před jejich vytvořením. 
  

Protokoly laboratorních měření (Laboratory Operation Protocols) 
Na tomto místě jsou uloženy soubory protokolů laboratorních měření. 
 

Soubory pole křivek (Curve Array Fines) 
Pokud nastavujete program můžete využít funkci Teach-in (Measure) pro vytvoření pole křivek. 
Křivky mohou být uloženy a opětovně načteny zpět do programu. 
Je zde specifikována úvodní složka pro tyto změřené křivky. 
 

Soubory statistiky (Statistic Fines) 
Toto je cesta k statistickým souborům. Tyto mohou být následné uloženy nebo zpět otevřeny 
v programu.  
 
Klikněte na tlačítko OK pro potvrzení změn. 
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Rozhraní (Interface) 
[Edit -> General Settings -> Interface] 
 

 
 

Device Communication (DIGIFORCE 9310) 
Fyzické propojení počítače (programu DigiControl) a přístroje DIGIFORCE 9310 je nezbytné.  
Porovnejte nastavení parametrů v programu a v přístroji pro dosažení nezbytného propojení. 
Ujistěte se, že přístroj DIFIGORCE 9310 není v menu ”RS232 + RS485” před hledáním zařízení 
(device search). Jinak nastavení zařízení nejsou ještě aktivní 
Pro více informací se podívejte do operačního manuálu přístroje DIGIFORCE 9310. 
 

Počítačové rozhranní (PC Interface ) 
Vyberte počítačový konektor, ke kterému je připojen přístroj DIGIFORCE 9310. V závislosti na 
operačním systému (Windows NT, Windows 2000...), tyto konektory musí být nedetekovány 
a nastaveny v systému. 
 

Kontrola bloku dat (Blockcheck) 
Aktivujte tuto volbu pro předcházení vzniku chyb při přenosu. 
Toto nastavení je možné pouze pro formát dat s 8 datovými bity. 
 

Baud Rate  
Vyberte rychlost 57600 baud pro docílení nevyšší přenosové rychlosti. 
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Formát dat (Data Format) 
Formát dat pro použité propojovací rozhraní- Pamatujte, že není možné aktivovat volbu kontrolu 
bloku dat pro jakékoliv nastavení ze 7 datovými bity! 
 

RS 485 Operation 
Zde můžete najít podrobnosti o rozhraní RS 485. 
 
 
Poznámka: standardní nastavení je zvýrazněno malými hvězdičkami!  
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Zabezpečení (Security) 
[Edit -> General Settings -> Security] 
 

 
 
Je možné nastavit dvě úrovně zabezpečení uživatelského rozhranní. 
Například je možné předejít přednastavení přístroje pomocí vybrání vyšší úrovně zabezpečení. Pro 
změnu parametrů je potom nutné vložit heslo. 
Když nastavujete zařízení, dává smysl nastavit nižší úroveň zabezpečení (standardní nastavení). Touto 
cestou je možné posílat všechny parametry z programu do zařízení a dělat změny, kde je potřeba.  
 
Důležitá poznámka:Bezpečnostní úroveň stejně jako informace jsou specifické podle 
přihlášeného uživatele na počítači. 
To znamená, že bezpečnostní úroveň musí být nastavena na počítači pod jeho/jejím 
uživatelským jménem. 
 

Vyšší bezpečnostní úroveň – změny pouze s heslem           
(High Security Level - changes only with password) 
Změny programu nebo nastavení zařízení mohou být prováděny pouze po vložení správného hesla. 
  

Nižší bezpečnostní úroveň – změny pouze s heslem            
(Low Security Level - changes after confirmation) 
Pokud jste udělali změnu nastavení je zobrazeno okno s potvrzením před změnou parametrů. Můžete 
se rozhodnout, zda změny provedete nebo zrušíte pomocí tlačítka Cancel. 
Není potřeba vkládat heslo. 
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Pod těmito body najdete další informace: 
 

Informace o uživateli (User information) 
Vložte informace vztahující se k uživateli nebo vaší společnosti. 
  

Heslo (Password) 
Informace o vkládání nebo změně hesla(Change Settings ...). 
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Heslo (Password) 
 
Pro změnu nastavení pro uživatele (User) je nutné vložit správné heslo. 
 

Vložení hesla (Enter Password) 
Klikněte na tlačítko Change Settings ... a vložte současné heslo do okna, které se objeví. 
 

 
 
Standardní heslo po instalaci je 1234.  
 

Změna hesla (Change Password) 
Pro změnu hesla je nutné vložit správné heslo. 
 
Nyní vyberte pole Password a vložte nové heslo podle vašeho přání. Nové heslo začne platit po 
potvrzení tlačítkem Yes.  
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Informace o uživateli (User Information) 
[Edit -> General Settings -> Security] 
 

 
 
Pro provádění změn v User Information nebo Security, musíte nejprve vložit heslo programu. 
Nyní mohou být změny provedeny v User Information. 
 

Jméno (Name) 
Po vložení hesla vložte jméno do položky programu. 
  

Společnost (Company) 
Po vložení hesla můžete vložit jméno vaší společnosti. 
  

Heslo (Password) 
Není možné vidět heslo pouze znaky, které jste napsaly jsou zobrazeny jako hvězdičky.  
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Činnosti (Actions) 
[Edit -> General Settings -> Actions] 
 

 
 
Pod položkou Actions můžete definovat činnosti, které mají být provedeny po každém měření. 
Každý vstup odpovídá jedné akci, která má být provedena jen pro specifické vyhodnocení výsledku 
nebo sekvence. 
 
S výběrem Selection můžete aktivovat nebo deaktivovat Plug-In pro určitý čas. 
 
S nastavením v odděleném dialogovém okně (Action Settings). Zde můžete nastavovat podrobnosti 
akce.
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Barvy (Colors) 
[Edit -> General Settings -> Colors] 
 

 
 

Barevné nastavení (Colour Settings) 
Můžete vybrat následující barvy pro reprezentaci změřených křivek: 
 
- Správný průběh měřené křivky (valuation OK) 
- Špatný průběh měřené křivky (valuation not OK) 
- Starší změřené křivky (pouze při Array of Curves v Programu-Measure) 
- Referenční kurzor 1 
- Pozice kurzoru 2 
- Pozadí 
- Barva mřížky grafu 
- Vyhodnocovací okno 
- Reference Curve 
- Referenční Min/Max křivky 
- Křivky obálky 
- Křivky sledování trendu 
 
Pro originální barevné schéma zmáčkněte tlačítko Standard Settings. 
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Reprezentace dat (Presentation) 
[Edit -> General Settings -> Presentation] 
 

 
 

Reprezentace změřených křivek (Measurement Curve Presentation) 
V záložce Measurement Curve Presentation můžete vybrat styl čáry na plný (line) nebo tečkovaný 
(dot) stejně jako tloušťku čáry. Toto je výhodné, když sledujete vzdálené hodnoty, ale například 
zobrazení ovlivňuje sklon křivky. 
Můžete také měnit hodnotu Measure Curve Count Quantity během učení (Teach-in (Measure) od 0 
do maximální hodnoty. S hodnotou vyšší než 1 obdržíte pole křivek, když provádíte učení. 
  

Zprávy (Messages) 
V této části můžete aktivovat zobrazování následujících zpráv, pokud je to nutné: 
- Bezpečnostní zpráva, že program DigiControl 9310 komunikuje se zařízením s novějším SW a 

program nezná všechny příkazy. V tomto případě by jste měli požádat o novější verzi programu. 
- Bezpečnostní zpráva pokud při potvrzování změn zmáčknete Cancel. 
 
Můžete změnit nastavení do výchozích hodnot pomocí tlačítka Standard Settings. 
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Záloha (Backup) 
[Edit -> General Settings -> Backup] 
 

 
 

Uložení nastavení (Download Settings) 
Tímto nastavením rozhodnete, zda budou uloženy všechny programy (také ty nepojmenované) nebo 
jen přejmenované programy během vytváření záložních souborů (Save no-named Programs). 
 
Poznámka: Berte na vědomí, že aktivací tohoto nastavené prodloužíte dobu ukládání! 
 

Nahrání zálohy ze souboru  (Upload Backup file into device)    
(od DIGIFORCE firmware V200304) 
Reset to Base (Reset) 
Během nahrání záložních souborů budou všechny statistiky nastavení na základní hodnotu. Stejně tak 
hodnoty pro sledování trendu. 
 
Hodnoty ze souboru (Values from File) 
Pokud jsou statistické hodnoty přítomny v záložním souboru, tak kompletní statistiky stejně jako 
sledování trendů (pokud je aktivní) bude nahrazeno v zařízení. Tato vlastnost je užitečná, kde je více 
jako 8 měřících programů aktivních v každém přístroji DIGIFORCE®. 
 
Nezměněno (No Changes) 
Statistika přístroje DIGIFORCE® zůstává nezměněna během operace nahrání záložního souboru. 
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Tisk (Printing) 
[Edit -> General Settings -> Printing] 
 

 
 

Nastavení tiskárny (Printer Settings) 
Všechny systémem detekované tiskárny jsou obsaženy v seznamu. Standardní nastavení je vybrat 
tiskárnu, která bude použita pro tisk protokolů. 
Pokud preferujete rozdílnou tiskárnu měla by být vybrána v této nabídce programu DigiControl 9310.  
 
Grafické logo pro protokol (Bitmap File for Protocols) 
Pro tisk protokolů měření, statistických souborů, polí křivek, a nastavení parametrů přístroje můžete 
do dokumentu vložit vlastní logo dokumentu. 
Pomocí tlačítka Change vyberte grafický soubor s odpovídajícím rozlišením. 
 
Pokud toto logo později odstraníte pomocí tlačítka Remove znovu se objeví standardní logo firmy 
burster. 
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Měřící mód (Measurement Mode) 
[Edit -> General Settings -> Measurement Mode] 
 

 
 

Nastavení (Settings) 
Maximální počet křivek při poli křivek (Maximum number of curves in the curve array) 
Pokud Details -> Last Measurement curve je aktivní během měření, tak je počet křivek roven tomuto 
číslu. Hodnoty jsou v rozsahu od 1 do 100. Mějte na vědomí, že zpracování více křivek potřebuje víc 
a víc času. V kritických operacích by číslo křivek mělo byt malé. 
  
Sleduj kapacitu disku (Watch hard disk kapacity) 
Pokud chcete předejít pádu vašeho operačního systému z důvodu nedostatku místa na disku upravte 
hodnotu pro varovnou zprávu a zastavení módu měření. 
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RS 485 Operation 
 
Můžete zapojit několik zařízení DIGIFORCE 9310 a pro správnou činnost je možné koupit převodník 
RS 485 – RS 232 IC-485S (burster 9900-K339) pro zapojení do počítače.  
Používejte pouze 4 vodičové spojení! 
 
Použijte následující obrázek pro nastavení převodníku: 
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Měření (Measure) (Teach-in Array of 
Curves) 
 
Pole křivek může být nahráno pro 20 měření. Maximální hodnota může být nastavena v General 
Settings – Presentation. 
S pomocí tohoto souboru křivek může být vytvořena obálka nebo mohou být rozmístěna 
vyhodnocovací okna. Mimo to mohou být průběhy vytisknuty nebo uloženy.  
Mějte na vědomí: během měření souboru křivek je statistický čítač v zařízení DIGIFORCE® 
vypnutý.  
 

 
 

Měření (Measure) 
Předešlý obrázek ukazuje změnu barvy vybrané křivky. 
  
Vybraná (Active) 
Změřená křivka je vybraná pro výpočet v dialogu Parameterize Program, pokud je ve vybraném řádku 
zaškrtnuta v seznamu. Když je křivka deaktivována může se křivka smazat. 
Během zachycování křivek výsledný soubor je vždy nahráván od hora dolů (do maximální kapacity 
změřených křivek) a předchozí křivky jsou jednoduše přepsány v seznamu. Dokud je zaškrtávátko 
aktivní.  
 
Změřené hodnoty (Meas. Val.) 
Množství změřených hodnot (Measurement Values) odpovídá počtu změřených křivek. 
 
Popis (Description) 
Pro přidání příslušného popisu (Description) musíte jednoduše vstoupit do textového pole. Nicméně 
berte na vědomí, že změřená křivka musí být aktivní.  
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Výsledek (Result) 
Zobrazí odpovídající výsledek po vyhodnocení měření.  
 
Pozastavení (Pause) 
K pozastavení měření pro krátký čas. Mimo jiné toto nastavení aktivuje čítač statistiky. 
  
Smazání (Delete) 
Zmáčkněte toto tlačítko pro smazání všech změřených křivek a začněte nové. 
 

Přiblížení (Zoom) 
Pro přiblížení křivky je určeno přiblížení Zoom. Máte na výběr mezi Manual, Auto a nastavením os 
z přístroje DIGIFORCE. 
 
Ruční (Manual) 
V tomto režimu (Manual Zoom) zůstávají hodnoty rozsahu stálé podle hodnot v polích X-min /        
X-max / Y-min / Y-max.  
 
Automatické (Auto) 
Při tomto nastavení jsou všechny křivky zobrazeny celé a hranice zobrazení se průběžně mění.  
Z DIGIFORCE (from DIGIFORCE) 
Vyberte tuto variantu pokud máte v úmyslu zůstat v grafickém rozlišení DIGIFORCE®.  
 
X-min / X-max / Y-min / Y-max 
Tyto hodnoty reprezentují hranice zobrazení. V ručním režimu mohou být upravovány. 
 

Přibližování pomocí myši (Capture the zoomed area with the mouse) 
Při držení klávesy CTRL, když je zmáčknuté levé tlačítko myši se zobrazí čárkovaný 
obdélník, který se po puštění levého tlačítka myši roztáhne na celou plochu grafu. 
 

Přijmout (Akcept) 
Pro přijmutí nahraných křivek zmáčkněte tuto klávesu. Mějte na paměti, že předešlé nahrané křivky 
mohou být přepsány v okně Parameterize Program , pokud nebyly ještě uloženy. 
 

Cancel 
Pokud chcete zahodit měření zmáčkněte tlačítko Cancel. 
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Obálka (Envelope) 
 

Základní (General ) 
Funkce obálky slouží jako přídavná vyhodnocovací metoda. Změřené křivky musí probíhat obálkou 
bez překročení horních a dolních limitních hodnot pro vyhodnocení jako správného průběhu. 
 
Vytváření obálky: 
Referenční křivka je vytvořena s pomocí souboru měření křivek. Tento výsledek je založen na výpočtu 
průměrných hodnot. Stejně jako je vytvořena maximální a minimální referenční křivka, která odpovídá 
kladnému a zápornému limitu referenční křivky. 
Minimální a maximální referenční křivky jsou použity pro vytvoření hranic obálky. Ta může být 
rozšířena nastavením hodnoty Delta-Y. Dále je možnost nastavení platnost obálky v souřadnicích osy 
x. 
 

 
 

Možnosti zobrazení (Display options) 
Z jasných důvodů může být velice užitečné zobrazit nebo schovat určité křivky pokud pracujete na 
nastavení parametrů obálky. Toto je učiněno v display options. Nastavení barev pro jednotlivé křivky 
může být provedeno v General Settings – Colors; způsob zobrazení křivky (tloušťku nebo styl) může 
být proveden v GeneralSettings – Presentation. 
 
Zobrazit pole křivek (Show Array of Curves) 
Pokud nastavíte parametry dialogového okna programu k nahrání souboru křivek ze souboru nebo 
změřením mohou být touto volbou vypnuty/zapnuty.  
 
Zobrazit referenční křivku (Show Reference Curve) 
Vyberte toto nastavené pokud má být referenční křivka zobrazena.  
 
Zobrazit Min/Max referen ční křivky (Show Min/Max Reference Curves) 
Tímto nastavením vybíráte, zda má být minimální a maximální referenční křivka zobrazena nebo ne.  
Výběr možnosti curve line / curve band může být učiněn v GeneralSettings – Presentation. 



Operační  manuál                                                    PC-Software  DigiControl 9310                                                        Strana 82 z 121   

Zobrazit k řivky obálky (Show Envelope Curves) 
Tímto nastavením vybíráte, zda má být obálka viditelná.  
Výběr možnosti curve line / curve band může být učiněn v GeneralSettings – Presentation. 
 
Zobrazit k řivku trendu (Show Trend Curves) 
Tímto nastavením určujete, zda je křivka trendu zobrazena. 
Výběr možnosti curve line / curve band může být učiněn v GeneralSettings – Presentation. 
 

Přiblížení (Zoom) 
Přibližování změřené křivky je prováděno pomocí funkce Zoom. Máte na výběr mezi  Manual, Auto 
a from DIGIFORCE. 
 
Ruční (Manual) 
V tomto režimu (Manual Zoom) zůstávají hodnoty rozsahu stálé podle hodnot v polích X-min /        
X-max / Y-min / Y-max.  
 
Automatické (Auto) 
Při tomto nastavení jsou všechny křivky zobrazeny celé a hranice zobrazení se průběžně mění.  
Z DIGIFORCE 
Vyberte tuto variantu pokud máte v úmyslu zůstat v grafickém rozlišení DIGIFORCE®.  
 
X-min / X-max / Y-min / Y-max 
Tyto hodnoty reprezentují hranice zobrazení. V ručním režimu mohou být upravovány 
 

Přibližování pomocí myši (Capture the zoomed area with the mouse) 
Při držení klávesy CTRL, když je zmáčknuté levé tlačítko myši se zobrazí čárkovaný 
obdélník, který se po puštění levého tlačítka myši roztáhne na celou plochu grafu. 
 

Navigace (Navigation) 
Navigace v grafu může probíhat pomocí šipek na klávesnici nebo programových kláves šipek. Dále je 
možné posouvat grafem při zmáčknutém levém tlačítku myši. 
 

Přijetí (Akcept) 
Pro přijetí změn zmáčkněte tlačítko accept. 
Důležité! Toto nastavení je posláno do přístroje pouze po zmáčknutí tlačítka accept nebo Save 
Program Settings v okně Parameterize Programs! 
 

Cancel 
Zmáčkněte tuto klávesu pokud chcete zahodit změny, které byly provedeny. Parametry předchozího 
nastavení budou obnoveny.  
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Parametry obálky (Envelope Parameter) 
 

 
 

Obálka (Envelope) 
 
On / Off 
Povolit nebo zakázat vyhodnocování obálky. 
 
X-min / X-max 
Pole určují začátek a konec obálky. 
 
Delta-Y 
Tato hodnota určuje o jaký interval bude obálka rozšířena oproti minimální a maximální změřené 
hodnotě pomocí křivek. 
  

Křivka trendů (Trend Curve) 
 
On / Off 
Povolit nebo zakázat vyhodnocování křivky trendu a sledování trendu. 
 
Delta Trend 
Tato hodnota určuje změnu od křivky limitu obálky a limitu křivky trendu. Tyto hodnoty trendu nesmí 
být překročeny křivkou obálky v měřícím módu jinak je měření označeno za špatné při zapnuté funkci 
sledování trendu. 
  
Váhování (Weighting) 
Váhování udává vliv měření na sledování obálky v limitech trendu. Váhování ½ má největší a 1/256 
má nejmenší vliv na změnu trendu. 
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Změna obálky (Edit Envelope) 
 

 
 

Změna obálky (Edit Envelope) 
 
Vypnuto (Off) 
Potřebujete vybrat horní a dolní křivku pro změnu obálky ručně. 
 
Horní k řivka (Upper curve) 
Pro změnu horní referenční křivky potřebujete toto nastavení zapnout. Poté můžete potřebnou křivku 
nakreslit od ruky za držení levého tlačítka myši. Měli byste postupovat pomalu a pokud možno zleva 
doprava tak, aby mohlo být zaznamenáno tolik bodů kolik je potřeba pro kalkulaci. 
  
Důležité: Zůstaňte nad referenční křivkou pokud pracujete na horní referenční křivce! 
  
Spodní křivka (Lower curve) 
Pro změnu horní referenční křivky potřebujete toto nastavení zapnout. Poté můžete potřebnou křivku 
nakreslit od ruky za držení levého tlačítka myši. Měli byste postupovat pomalu a pokud možno zleva 
doprava tak, aby mohlo být zaznamenáno tolik bodů kolik je potřeba pro kalkulaci. 
 
Důležité: Zůstaňte pod referenční křivkou pokud pracujete na dolní referenční křivce! 
 
Zpět (Undo) 
Grafická editace obálky může být vrácena pomocí stlačení tlačítka Undo do hloubky 10 kroků. 
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Základní nastavení (Default Initializing) 
[Edit -> Default Initializing] 
 
Vyberte Default Initializing v menu Edit. Otevře se následující okno:  
 

 
 
S základní inicializací (Default Initializing), jsou všechny parametry programu resetovány. 
(inicializovány na standardní hodnotu). Následné je program v originálním nastavení z továrny. 
 
Důležité upozornění: Veškeré vámi nastavené parametry jsou ztraceny po inicializaci. Proto je 
vhodné si předem udělat zálohu. 
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Změna statistiky (Edit Statistic) 
[Edit -> Statistic] 
 
Vyberte Statistic v menu Edit. Otevře se následující okno:  
 

 
 

Přečíst statistiky (Read Statistic ) 
Stiskněte toto tlačítko pro přečtení měřících programů z DIGIFORCE®. V závislosti na nastavení 
měřícího programu obdržíte dostupné statistiky. Tyto statistiky mohou být vymazány pomocí  Perform 
Reset. 
 

Nahrát (Load) 
Statistické údaje, které byly předem uloženy mohou být načteny a například vytištěny.  
 

Uložit (Save) 
Statistické údaje, které byly předem načteny z DIGIFORCE® mohou být uloženy jako upravitelný 
soubor statistik a znovu vytisknuty v pozdější době. 
  

Vytisknout (Print) 
Při tisku statistických údajů je nejprve nutné načíst data z DIGIFORCE® nebo načíst statistiky ze 
souboru. Všechny dostupné statistiky budou vytištěny z DIGIFORCE®: 
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Podrobnější informace o náhledu tisku dostanete zde. 
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Vynulování statistik (Statistic Reset) 
[Edit -> Statistic Reset] 
 
Po vybrání Statistic Reset v menu Edit. Se objeví následující okno: 
 

 
 
Každý měřící program obsahuje následující statistická data: 
- Počítadlo kusů 
- Počítadlo špatných kusů 
- Počítadlo nesplněných podmínek pro okna 1 až 3 
- Počítadlo nesplnění podmínek obálky (od DIGIFORCE® firmware V200304) 
- Počítadlo nesplnění trendů (od DIGIFORCE firmware V200304) 
 
Pro vybrané programy budou všechny čítače budou nastaveny na 0. 
 
Důležité upozornění: Uvědomte si, že dojde ke smazání všech statistických dat u vybraných 
programů! Důkladně zvažte vytvoření záložního souboru případně zálohu veškerého nastavení 
přístroje. 
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Export 
 

 
 
Během měření nebo později je možné exportovat data měření v ostatních formátech jako je například 
*.xls (Excel). Při pozdějším exportu je možné podle kritérií vybrat jen tyto pro export. Pro převod 
musí být vybrány odpovídající plug-iny. 
  
Nahrané Plug-iny (Installed Plug-Ins) 
Pokud jste už aktivovali Plug-iny v nastavení objeví se ve výběru „Installed Plug-Ins“. Vyberte ten 
správný podle vašich požadavků. 
  
Speciální Plug-iny (Special Plug-In) 
Pokud nechcete používat přeinstalované Plug-Ins potom vyberte položku „Special Plug-In“. 
 
Výběr souboru (File Selection) 
Pro export pouze vybraných protokolů zvolte z nabídky položku „Marked  protocols“. Výběr více 
souborů se provádí standardně (Při držení kláves CTRL nebo SHIFT a levým tlačítkem myši). 
Pokud si přejete vytisknout všechny protokoly ze seznamu vyberte položku „All protocols“. 
 
Podrobnosti (Details) 
V této části okna nejdete informace o použitém plug-inu jako je jméno (Name) a verze (Version). 
Pro většinu Plug-inů je možné nastavit výstupní složku v menu „special output directory“. 
Rozsáhlejší plug-iny mají možnost nastavení parametrů v jejich setupu. 
Pro podrobnější informace se podívejte do popisu rozhraní plug-inů. 
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Hledání skupiny protokolů (Search Group 
Protocols) 
[Measure -> Search and edit Measurement Protocols -> Search Group Protocols] 
 
V horní části tabulky jsou zobrazeny otevřené skupiny protokolů. Každá skupina obsahuje minimálně 
jedno a maximálně 32 členů skupiny. Členové skupiny jsou zobrazeny ve spodní části tabulky. 
  

 
 
Pro každou položku vybranou (modré pozadí) v horní části jsou ve spodní části zobrazeny jednotlivé 
protokoly členů. Ty jsou dostupné jako soubory protokolů. Nicméně jen ty mohou být otevřeny 
(pomocí tlačítka Open all single protokols), které mají aktuálně jméno souboru v řádku „file name”. 
Pokud v této položce není žádný vstup potom soubory protokolu nebyly uloženy (koukněte se do 
kapitoly Nastavování činností (presettings  Actions)). 
 
Pokud byl soubor protokolů později upravován pak se objeví vstup „Data checksum NOK“ pro 
odpovídající skupinu protokolů.  
 
Pro tisk skupiny protokolů jako seznam nebo jako jednotlivé stránky stiskněte tlačítko Printout group 
protocols.... 
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Tisk skupiny protokolů (Print group 
protocols) 
[Open protocols -> Search for group protocols -> Open -> Print group protocols] 
 

Výběr (Selection) 
Při tisku je možné vybrat tisk všech protokolů All  (všechny ze seznamu) nebo pouze vybrané 
(Selected) protokoly. Toto se provádí v okně tisku. Při výběru protokolů postupujte standardně 
(držením klávesy CTRL nebo SHIFT a označováním levým tlačítkem myši) 
 

Nastavení tisku (Print Options) 
 
Stránka (Page) 
Skupinový protokol je vytištěný na jednu stránku. Zobrazeny jsou celkový skupinový výsledek stejně 
jako výsledky jednotlivých měření. Volitelně je přítomno jméno pracovníka a popis. Pokud toto není 
požadováno musí být tyto položky odstraněny v odpovídajících polích. 
 
Seznam (List) 
Jako přehled vybraných skupin protokolů je možnost vytisknout jej ve formě seznamu. Každý 
protokol obsahuje maximálně 40 skupin v odpovídajících řádcích.
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Spuštění módu měření (Start Measurement 
Mode) 
[Measure -> Start Measurement Mode] 
 

 
 
Jsou přítomny dva módy měření:  
 
Jednoduchý měřící mód (Simple measurement mode) 
Všechny přístroje vybrány ve skupinovém seznamu jsou dotázány na výsledky měření v nekonečné 
smyčce. Každý nový výsledek měření může být přenesen do počítače v závislosti na nastavení 
parametrů stanice, jejím nastavení, uložen podle specifických pravidel a případně plug-inů. 
 
Mód měření se skupinou přístrojů (Measurement mode with device group) 
Nastavení tohoto operačního módu je v podstatě stejný jako pro předchozí mód. Nicméně jedna nebo 
více stanic může tvořit jednu skupinu a společné výsledky musí být zobrazeny. Podrobnosti  této 
skutečnosti mohou být nalezeny v definici skupiny zařízení. 
 
Obecné (General) 
Během měřícího módu můžete vybrat zařízení jehož výsledky (výsledek, počet změřených hodnot, 
výrobní číslo a další) si přejete vidět mohou být zobrazeny pomocí tlačítek v horní části menu.  
 
Podrobnosti (Details) 
Pokud je funkce (Details) aktivní můžete vidět následující záložky v závislosti na operačním módu:  
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Časová statistika (StatisticTime )(1) 
Statistika správných (OK) a vadných (NOK) měření jedné stanice je zobrazena za celý den. 
Pokud začne nový den statistika se během měření vynuluje. 
Nastavení zobrazení statistiky je možné na side by side nebo one upon the other. 
 
Statistika skupiny zařízení (Statistics device group) (2) 
V této statistice je zobrazen celkový výsledek skupiny zařízení jako celkový výsledek měření. Více 
informací je dostupných v Device Group Statistic. 
 
Poslední změřená závislost (Last measurement curve) (1)+(2) 
Můžete vidět poslední změřenou křivku stanice, pokud jsou změřené křivky zahrnuty do sběru dat pro 
odpovídající stanici (provedeno v menu Properties -> Measmode) 
Volitelně může být vytvořena skupina měření (aktivace v General Settings -> Measmode). 
Nicméně mějte na vědomí, že grafická reprezentace svazku křivek je přídavné zatížení systému 
a zvětšuje čas potřebný pro měření v závislosti na datové propustnosti. 
Proto by měla být vybrána pouze možnost zobrazení poslední změřené křivky pro nekritické procesy 
a v testovací fázi měření. 
 
 
Zaznamenávání činností a dat (Actions and data capture)(1)+(2) 
 
Popis zaznamenávání dat (Description of data capture) informuje o datech, která jsou 
zaznamenávány pro vyhodnocení. Například informuje o aktuálním posílání dat ze stanice do počítače. 
 
Popis činností (Action description)  informuje co se stalo z posledními zaznamenanými daty. 
Například spuštění konkrétního plug-inu (např.: statistiky EXCEL statiky) může být spuštěno 
v závislosti na výsledku vyhodnocení. Před-podmínka pro toto je vždy Action Protocol File. 
 
Zprávy (Messages) 
V této tabulce mohou být obsaženy například chyby přenosu nebo jiné důležité zprávy. Stavový řádek 
vás bude informovat o množství zpráv stejně jako o varování.  
 
Různé  
• Pokud máte konfigurační software 9310-P101 můžete testovat výrobní mód po maximální dobu 

3 minut. Poté bude automaticky ukončen.  
• Nastavení všech viditelných dialogů je uloženo při uzavírání programu a obnoveno při jeho 

spuštění.  
 
Důležitá poznámka 
• Zvažte signál Ready od všech připojených přístrojů DIGIFORCE během měřícího módu! Jinak 

nedefinovaný start zařízení může vést k nechtěné ztrátě dat! Přenos dat je přerušen okamžitě po 
STARTU! 

 
(1)= Spojeno se zařízením 
(2)= Spojeno se skupinou 
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Automatický start měřícího módu 

 
Následujte postup pro spuštění měřícího módu automaticky po spuštění počítače: 
 
- Vytvořte zástupce programu  DigiControl 9310 ve složce po spuštění v uživatelském profilu 
operačního systému Windows:  
 

 
 
- Klikněte pravým tlačítkem myši na zástupce a vyberte vlastnosti (settings). Upravte políčko cíl 
(target) vložením prázdného znaku a znaménka plus po horních uvozovkách na konci cesty odkazu. 
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Po této změně program  DigiControl bude automaticky nastaven do měřícího módu po restartu 
a vybrání uživatele.  

 
Stejný výsledek je dosažen také stiskem tlačítka v bloku Auto start s možností nastavené prodlení.
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Nastavení činností (Action Settings) 
[Properties -> Actions -> Properties] 
 

 
 
Máte možnost uložit poslané data měření a případně s nimi pracovat s pomocí Plug-Inů. 
 
Přidat (Add... ) 
Musíte zmáčknout tlačítko Add pro přidání speciálního plug-inu do vybraných činností vybraných 
v General. Následně zobrazený dialog dovolí výběr vhodných plug-inů. 
 
Odstranit (Remove) 
Použitím tohoto tlačítka odstraníte vložený Plug-In ze seznamu. 
 
Výběr (Selection) 
S pomocí tohoto tlačítka je určeno, který výsledek měření způsobí vybrání této činnosti. 
  
Pořadí (Sequence) 
Tato položka ukazuje za jaký počet měření vybraná akce bude znovu provedena.  
Příklad: 
Vstup 1: Selection OK / Save Protocol file / Sequence = 5 
Vstup 2: Selection NOK / Save Protocol file / Sequence = 2 
Vstup 3: Selection OK / Save Protocol file / Sequence = 10 / Plug-In „Curve.dll“ 
 
Toto nastavení vede k provedení vstupu 1 a 3 pro první OK měření a vstupu 2 pro první NOK měření. 
Mimo jiné 6 OK měření provede akci 1, třetí NOK měření provede vstup 2 a 11 OK měření provede 
vstup 3. Stejným způsobem se pokračuje. 
 
Soubor protokolu (Protocol file) 
Soubor protokolu je aktivní jako standardní zatím není možné zpracovávat data Plug-Ins! 
 
Důležitá poznámka! Změřená data, která nejsou nahrána (nejsou přítomna v protokolu) nemohou být 
později zpracována (například pomocí plug-inů). Měli byste toto zvážit, když vyhodnocujete změřená 
data nebo exportujete data pomocí plug-inů. Udělejte správnou konfiguraci v Properties v měřícím 
módu pro transfer a nahrání správných dat měření.!  
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Plug-Iny 
 
Dva plug-iny do Excelu jsou obsaženy s dodávkou programu. 
  
Curve.dll 
Změřená data jednoho souboru protokolu jsou uloženy do jednoho souboru Excelu. Kde jsou uloženy 
veškeré obsažené data. 
Soubor Excelu je uložen do stejné složky jako protokoly měření. 
V nastavení (Properties) můžete vybrat data, která mají být z přístroje automaticky přeneseny 
v měřícím módu. 
  
Statistic.dll 
S pomocí tohoto plug-inu jsou důležitá data jako jsou vstupní a výstupní hodnoty z vyhodnocovacích 
oken jsou uloženy do souboru Excelu. Pokud se změní stanice měřící program bude vytvořen Nový 
soubor! V každém řádku jsou uložené hodnoty z DIGIFORCE, které mají spojitost s procesem nebo 
jednou částí. Každý sloupec odpovídá jedné charakteristice například rozptyl sil sledovaný pro mnoho 
tisíců měření. 
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Popis rozhraní Plug-inů 
 
Popis rozhraní plug-inů je stále v procesu vývoje a bude doděláno v dalších verzích! 
 
 
 
 
 
 
 
 
 
 

Ready-Mode 
 
Potřeba dokumentování změřených průběhů při lisování začíná být důležitým kritériem. To může být 
nezbytné pouze po testovací období nebo musí být dokumentace tvořena bez přerušení pro možnost 
vysledování nebo upřesnění důvodů. Nicméně toto vyžaduje ukládání veškerých změřených dat. 
Mimojité vyrobená součást bez protokolu může být bezcenná!  
 
Přístroj DIGIFORCE® 9310 ukládá pouze změřené výsledky lisování.  Pokud je zařízení znovu 
odstartováno jsou výsledky přepsány novými hodnotami. Staré hodnoty jsou ztraceny navždy. 
Z tohoto důvodu musí být změřené hodnoty poslány přes sériové rozhranní v časech mezi lisovacím 
procesem. Jak toho dosáhnout? Jak řídící systém ví, že byl přenos dokončen a může začít nové 
lisování?  
 
Rozhodujícím signálem je DIGIFORCE-signál READY. Pokud je READY=1 nový strojový cyklus 
může následovat s READY=0 musí systém čekat! Docela jednoduché! READY je obvykle ovlivněn 
statusem přístroje DIGIFORCE. Pokud je READY=1, zařízení skončilo s měřením a vyhodnocením a 
je připraveno pro další proces. Pokud je READY=0, DIGIFORCE stále pracuje na měření nebo na 
vyhodnocení. 
 
Speciálním případem nazvaným READY-Mode=PC-CONTROLLED, vytváří závislost READY na 
jiných podmínkách.. Pokud přístroj DIGIFORCE je v procesu přenosu dat, potom READY může 
zůstat v nule dokud PC nepošle příkaz „fr“ (pro uvolnění READY) viz pic.1.  
 
Pro detailnější popis: 
 
Na začátku, DIGIFORCE je v READY-Mode “NORMAL” (viz pic. 1). The READY-Signal je 
kontrolován statusem zařízení! Sériová komunikace nemá na tento signál v tomto pohledu vliv! 
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Pro přesun změřených dat bez přestávky nebo poruch, vytvoření READY signálu musí být řízeno 
počítačem. PC přepne DIGIFORCE do READY módu „řízeného PC“ pomocí poslání příkazu „sr“ 
(relé je v dolní pozici na pic. 2). READY je nyní závislé na jiné podmínce, která je nazývána READY-
Release. Toto je dáno počítačem pouze po získání všech dat přes sériové rozhraní). Následně je poslán 
příkaz „rf“, který znovu uvolní READY signál. Pokud to status přístroje dovolí je dán do úrovně „1“. 
PLC může spustit další strojový cyklus a aktivovat START signál na přístroji DIGIFORCE.  
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Po každém spuštění je přístroj nastaven do READY-Mode „NORMAL“ a READY release je 
nastaveno na 0.  
 
Co se stane pokud počítač zamrzne? 
  
To je vhodně zvolená otázka, co se stane pokud PC zamrzne, když je DIGIFORCE v režimu „PC-
controled“, před posláním příkazu „rf“ například při přenosu dat. Zamrzne celý systém jako následek 
zamrznutí PC?  
 
Né nezbytně! Nicméně pokud PLC zajímá pouze READY-signál toto bude pravdivé. Systém se 
zhroutí! Profesionální programátoři PLC by měli ve svém programu integrovat funkci vypršení 
požadavku nebo hlídání pomocí WATCHDOGu, aby nedošlo k této situaci. Pokud vyprší čas pro 
READY měl by systém přejít do režimu poruchy, pokud musí být sběr dat proveden za všech 
podmínek. Pokud je nepřetržitá produkce více důležitá je READY signál ignorován přístroj 
DIGIFORCE restartován a případně je poslána varovná zpráva. To je vše. 
  
Po vyřešení problému a PC restartovalo program, který donutí DIGIFORCE přejít znovu do READY-
Mode „PC-CONTROLLED“.  
 

Software DigiControl 9310-P100 od firmy burster podporuje dříve popsaný 
READY-Mode! 
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Licencování 9310-P100 
[Measure -> Start Measurement Mode...] 
 

 
 
Existují dvě verze programu: 
 
9310-P101 Základní verze pro konfiguraci, zálohu a laboratorní operace. 
9310-P100 Jako verze 9310-P101 doplněná o mód automatického měření.  
 
Automatický mód měření může být testován ve verzi programu 9310-P101 po dobu 3 minuty 
neomezeně krát.   
Pokud máte verzi programu 9310-P101 vždy můžete upgradovat na verzi 9310-P100. Bude vám 
posláno licenční číslo, ke kterém budete uvedeni jako oprávněný uživatel. 
Pro otázky ohledně upradu kontaktujte Mr. Bräuer at e-mail Klaus.Braeuer@burster.de  nebo přímo na 
čísle +49-7224-645-51. 
 
Podpora v měřícím módu vám bude poskytnuta pouze po předložení platného licenčního čísla. 
 
Uživatel (User) 
Vložte jméno na které bude software registrován. Informujte nás o tomto jméně pro případ podpory 
nebo odkazu na licenční číslo. 
 
Licenční číslo (Product key) 
Vložte 20 číslic licenčního čísla do připraveného pole. 
Nejsou rozdíly mezi velkými a malými znaky. 
Zmáčkněte klávesu Accept pro potvrzení správnosti vloženého čísla verze 9310-P100.  
 
Tří minutový test 
Pokud provozujete verzi programu 9310-P101 můžete spustit automatický mód měření nepřetržitě 
maximálně po dobu 3 minut.  



Operační  manuál                                                    PC-Software  DigiControl 9310                                                        Strana 102 z 121   

Řízení komunikace 
 
DigiControl 9310 může být částí komunikace přes druhé COM rozhraní. Toto může být nutné 
například pro spuštění nebo zastavení měřícího módu nebo pro přepnutí jednoho měřícího programu 
na druhý nebo pro přenos kompletního nastavení zařízení do přístroje. Podporované příkazy jsou 
vyjmenovány.  
 
Mějte na vědomí, že: 
• Závorky < / > slouží pouze snažší rozpoznání parametrů uživatelem a nejsou posílány. 

 
Commands for an active device group: 
Command  Command reference  Popis 
SRA <Note> SetRemarkGroupA Nastavit jméno skupiny (device group) 
GRA GetRemarkGroupA Poslat dotaz na jméno skupiny (device group) 
SNA <counter number> SetNumberSerialGroupA Nastavit nové výrobní číslo pro skupinu zařízení  
GNA GetNumberSerialGroupA Poslat dotaz na výrobní číslo skupiny zařízení 
SP1A <Value> SetParameter1GroupA Nastavit Part-No. %1 skupiny zařízení 
GP1A GetParameter1GroupA Poslat dotaz na Part-No. %1 skupiny zařízení 
SP2A <Value> SetParameter2GroupA Nastavit Part-No. %2 skupiny zařízení 
GP2A GetParameter2GroupA Poslat dotaz na Part-No. %2 skupiny zařízení 
SBA <Value> SetBatchGroupA Poslat a aktivovat manuální charge skupiny zařízení 
GBA GetBatchGroupA Dotázat se na manuální označení charge skupiny zařízení 
SCA <Value> SetComponentNameGroupA Nastavit jméno výrobku skupiny zařízení 
GCA GetComponentNameGroupA Dotázat se na jméno výrobku skupiny zařízení 

 
Základní příkazy: 
Command  Command reference  Popis 
SM SetMode Nastavení měřícího módu 
GM GetMode Dotaz na měřící mód 
SP <Address> <MP-No.> SetProgram 

Přepnout měřící program stanice * 
GP <Address> GetProgram 

Dotaz na aktivní měřící program * 
SN <Address> <Counter no.> SetNumberSerial Nastavit nové číslo Part-No. čítače na stanici 
GN <Address> GetNumberSerial Poslat dotaz na číslo Part-No. čítače na stanici 
SP1 <Address> <Value> SetParameter1 Nastavit Part-No. %1 stanice 
GP1 <Address> GetParameter1 Dotaz na Part-No. %1 stanice 
SP2 <Address> <Value> SetParameter2 Nastavit Part-No. %2 stanice 
GP2 <Address> GetParameter2 Dotaz na Part-No. %2 stanice 
SB <Address> <Charge> SetBatch Přejmenovat ruční charge stanice 
GB <Address> GetBatch Dotaz na ruční charge stanice 
SR <Address> <Remark> SetRemark Nastavit poznámky na stanici 
GR <Address> GetRemark Dotázat se na poznámky na stanici 
UF <Address> <Data path> UploadFile 

Nahrání záložního souboru do stanice * 

 

* = Tyto funkce mohou být provedeny pouze při neaktivním měřícím módu! 

 
Parametry příkazů GM/SM: 
Parameter value  Popis  
-1 Mód měření vypnutý 
0 Under process 
1 Měřící zapnutý 
2 Měřící mód pozastaven 

 
Parametry spontánních zpráv: 
Parameter value  Command reference  Popis 
@-1 DigiControlExit DigiControl zastaven 
 @0 DigiControlStartedStandard DigiControl (standard) spuštěn 
 @1 DigiControlStartedPlus DigiControl PLUS spuštěn 
 @2 UploadFileReady Nahrávání ukončeno 
 @3 <Addess program result> MeasurementResultAvailable Výsledky měření (Address, program and result) 
 @4 MeasurementStateOff Vypnout měřící mód 
 @5 MeasurementStatePaused Měřící mód pozastaven 
 @6 MeasurementStateOn Zapnout měřící mód 
 @10 GroupResultAvailable Dostupnost skupinového výsledku 
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Příklad komunikace přes PLC- kontrol 
 
• Nahrávání změřených dat se sériovým číslem dodaným PLC s DigiControl 9310 v automatickém 

měřícím módu: 
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Hledání protokolů (Search for protocols) 
[Measure -> Search and edit measurement protocols...] 
 
Jsou možné následující způsoby, jak hledat protokoly získané při automatickém měřícím režimu: 
 
Hledat měřící protokoly s asistencí (Search measurement protocols with the 
assistant) 
Povolí automatické hledání jednotlivých měřících protokolů s pomocí filtru (výsledek měření, měřící 
program, čas, název stanice, atd.). 
 

Hledat skupinu protokolů s asistencí (Search group protocols with the assistant) 
Dovoluje automatické hledání skupiny měřících protokolů s pomocí filtru (skupina výsledků, datum, 
úkol, výrobní číslo). 
 
Ruční výběr jednoho měření nebo skupiny protokolů 
Seznamem ve vybrané složce obsahující jednotlivé měření nebo skupinu měření. 
Pro výběr nemůže být použito filtru. 
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Hledání měřících protokolů (Search 
Measurement Protocols) 
[Measure -> Search and edit Measurement Protocols-> Search Measurement Protocols] 
 

 
 
Můžete hledat jednotlivé protokoly měření, které byly nahrány během měření pomocí následujících 
filtr ů:  
 
Všechny parametry  mají jako základní nastavení *, toto nastavení obvykle znamená deaktivaci filtru. 
Pokud je zadaný text pouze částečný doporučujeme před a za text přidat znak hvězdičky (*).  
 
Komponent (Component) 
Název komponenty je určen v nastavení stanice a zde může být nalezen specifický protokol s jeho 
jménem. Jméno komponentu by mělo být shodné s názvem programu. Pro snadnější hledání 
používejte výmluvné názvy.  
 
Charge 
Jméno bylo specifikováno v nastavení přístroje a specifické jméno protokolu může být zde nalezeno. 
Obvykle odpovídá časovému období. 
 
Číslo výrobku (Part-no.) 
Můžete hledat určité číslo výrobku. Číslo odpovídá běžícímu čítači, který je synchronizován podle 
úkolu nebo podle ručního nastavení. V nejjednodušším případě označuje číslo kusů v DIGIFORCE. 
Volitelně pro mód měření je zde přídavný parametr %1 a %2, který může být vložen před a za číslo 
čítače. (v device list -> Properties  Measurement Mode). Mějte na paměti, že číslo čítače by mělo 
existovat jen jednou jinak protokoly nejsou jednoznačné.  
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Číslo programu (MP-No.) 
Tento parametr informuje o použitém čísle měřícího programu v DIGIFORCE 9310.  
 
 
Jméno programu (MP-Name) 
Název komponentu je obvykle identický s názvem programu. Preferováno by mělo být srozumitelné 
označení. 
 
Datum (Date) 
Vyberte předdefinované časové období. Časový filtr je možné deaktivovat pomocí výběru možnosti 
„any date”.  
Všechny ostatní nastavení obsahují specifické data nebo časová období. 
Pro nastavení data vlastnoručně je možné zobrazené rozsahy datum přepisovat .  
 
Výsledek (Result) 
Vyberte jen ON nebo NOK v závislosti na požadovaném zobrazení. Defaultní hodnota je zobrazovat 
OK i NOK výsledky.  
 
Název stanice /výrobní číslo DIGIFORCE / Název ve skupině (Station name / 
DIGIFORCE-SN / Name in the group) 
Vzhledem k nezbytné hierarchii můžete vybrat rozdílné nastavení odpovídající DIGIFORCE.  
- Nejvíce vypovídající je výrobní číslo (DIGIFORCE-SN). Odpovídá jedinečnému číslu DIGIFORCE.   
- Pokud během výroby musí být přístroje vyměněny nezbytně se změní výrobní číslo. Proto musí být 
následně pro hledání použito názvu stanice, které je možné změnit následujícím způsobem:  
Po dvojitém kliknutí levého tlačítka myši na stanici v seznamu zařízení uvidíte záložky ve kterých je 
položka název stanice. Další způsob je možný z menu: GENERAL SETTINGS -> INFO -> 
STATION. 
- Pokud pracujete například pouze s jedním, který je využíván ve dvou skupinách pro kontrolu dvojice 
produktů, může být hledán podle jména ve skupině (Name in the group). 
 
Hledání (Search) 
Pro začátek hledání zmáčkněte tlačítko Search. 
Během procesu hledání se objeví okno o průběhu a hledání může být kdykoliv vypnuto. Zobrazené 
položky, které byly při hledání v seznamu zůstanou i po přerušení hledání. 
Mimo to je možné bez změny původních parametrů filtru zobrazit maximální počet měřících 
protokolů.  
 
Jiná cesta (Another path) 
Stiskněte Another path.... pro hledání jiné cesty k hledaným protokolům. 
Při hledání nejsou prohledávány pod složky! 
 
Standardní cesta (Standard path) 
Pro návrat do původní složky zmáčkněte toto tlačítko:  

 
 
Otevřít všechny protokoly (Open all protocols) 
S aktivovaným nastavením všechny vypsané měřící protokoly jsou načteny do dialogového okna, , 
pokud je tato ožnout vypnuta načtou se pouze vybrané protokoly. 
 
Řazení (Sorting) 
Pořadí měřících protokolů záleží na způsobu řazení po hledání. Řazení lze změnit kliknutím levým 
tlačítkem myši na název sloupce podle, kterého je řazení požadováno.  
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Hledat skupinu protokolů (Search Group 
Protocols) 
[Measure -> Search and edit Measurement Protocols-> Search Group Protocols] 
 

 
 
Můžete hledat jednotlivé protokoly měření, které byly nahrány během měření pomocí následujících 
filtr ů:  
 
Všechny parametry  mají jako základní nastavení *, toto nastavení obvykle znamená deaktivaci filtru. 
Pokud je zadaný text pouze částečný doporučujeme před a za text přidat znak hvězdičky (*).  
 
Komponent (Component) 
Název komponenty je určen v nastavení stanice a zde může být nalezen specifický protokol  s jeho 
jménem.Jméno komponentu by mělo být shodné s názvem programu. Pro snadnější hledání používejte 
výmluvné názvy.  
 
Charge 
Jméno bylo specifikováno v nastavení přístroje a specifické jméno protokolu může být zde nalezeno. 
Obvykle odpovídá časovému období. 
 
Číslo výrobku (Part-no.) 
Můžete hledat určité číslo výrobku. Číslo odpovídá běžícímu čítači, který je synchronizován podle 
úkolu nebo podle ručního nastavení. V nejjednodušším případě označuje číslo kusů v DIGIFORCE. 
Volitelně pro mód měření je zde přídavný parametr %1 a %2, který může být vložen před a za číslo 
čítače. (v device list -> Properties  Measurement Mode). Mějte na paměti, že číslo čítače by mělo 
existovat jen jednou jinak protokoly nejsou jednoznačné.  
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Číslo programu (MP-No.) 
Tento parametr informuje o použitém čísle měřícího programu v DIGIFORCE 9310.  
 
 
Jméno programu (MP-Name) 
Název komponentu je obvykle identický s názvem programu. Preferováno by mělo být srozumitelné 
označení. 
 
Datum (Date) 
Vyberte předdefinované časové období. Časový filtr je možné deaktivovat pomocí výběru možnosti 
„any date”.  
Všechny ostatní nastavení obsahují specifické data nebo časová období. 
Pro nastavení data vlastnoručně je možné zobrazené rozsahy datum přepisovat .  
 
Výsledek (Result) 
Vyberte jen ON nebo NOK v závislosti na požadovaném zobrazení. Defaultní hodnota je zobrazovat 
OK i NOK výsledky.  
 
Název stanice /výrobní číslo DIGIFORCE / Název ve skupině (Station name / 
DIGIFORCE-SN / Name in the group) 
Vzhledem k nezbytné hierarchii můžete vybrat rozdílné nastavení odpovídající DIGIFORCE.  
- Nejvíce vypovídající je výrobní číslo (DIGIFORCE-SN). Odpovídá jedinečnému číslu DIGIFORCE.   
- Pokud během výroby musí být přístroje vyměněny nezbytně se změní výrobní číslo. Proto musí být 
následně pro hledání použito názvu stanice, které je možné změnit následujícím způsobem:  
Po dvojitém kliknutí levého tlačítka myši na stanici v seznamu zařízení uvidíte záložky ve kterých je 
položka název stanice. Další způsob je možný z menu: GENERAL SETTINGS -> INFO -> 
STATION. 
- Pokud pracujete například pouze s jedním, který je využíván ve dvou skupinách pro kontrolu dvojice 
produktů, může být hledán podle jména ve skupině (Name in the group). 
 
Hledání (Search) 
Pro začátek hledání zmáčkněte tlačítko Search. 
Během procesu hledání se objeví okno o průběhu a hledání může byt kdykoliv vypnuto. Zobrazené 
položky, které byly při hledání v seznamu zůstanou i po přerušení hledání. 
Mimo to je možné bez změny původních parametrů filtru zobrazit maximální počet měřících 
protokolů.  
 
Jiná cesta (Another path) 
Stiskněte Another path.... pro hledání jiné cesty k hledaným protokolům. 
Při hledání nejsou prohledávány pod složky! 
 
Standardní cesta (Standard path) 
Pro návrat do původní složky zmáčkněte toto tlačítko:  

 
 
Otevřít všechny protokoly (Open all protocols) 
S aktivovaným nastavením všechny vypsané měřící protokoly jsou načteny do dialogového okna, , 
pokud je tato ožnout vypnuta načtou se pouze vybrané protokoly. 
 
Řazení (Sorting) 
Pořadí měřících protokolů záleží na způsobu řazení po hledání. Řazení lze změnit kliknutím levým 
tlačítkem myši na název sloupce podle, kterého je řazení požadováno.  
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Ruční výběr (M anual Selection) 
[Measure -> Search and edit Measurement Protocols -> Manual Selection] 
 

 
 
Vyberte tlačítkem, které mění název z “Single protocol files“ do „Group protocol files“ pro správné 
zobrazení hledaných protokolů. 
Následně vyberte složku ve které si přejete protokoly zobrazit v pravé straně se zobrazí načtené 
protokoly, které jsou ve vybrané složce obsaženy. V levé části vybíráte aktivní složku. 
 
Standardní cesta (Standard path) 
Pro návrat do původní složky zmáčkněte toto tlačítko:  

 
 
Otevřít všechny protokoly (Open all protocols) 
S aktivovaným nastavením všechny vypsané měřící protokoly jsou načteny do dialogového okna, , 
pokud je tato ožnout vypnuta načtou se pouze vybrané protokoly. 
 
Řazení (Sorting) 
Pořadí měřících protokolů záleží na způsobu řazení po hledání. Řazení lze změnit kliknutím levým 
tlačítkem myši na název sloupce podle, kterého je řazení požadováno. 
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Protokoly (Protocols) 
[Measure -> Search and edit Measurement Protocols] 
 

 
 
Data měření, které byly vytvořeny při automatickém měření mohou být otevřeny , zobrazeny , měřící 
křivky mohou být zobrazeny nebo může být protokol vytištěn v této nabídce. 
Seznam zobrazuje v řádcích jednotlivé protokoly. Ty mohou být seřazeny podle sloupců kliknutím na 
název sloupce. Funkce Export... a Print... jsou provedeny v pořadí jak je seřazeno menu!  
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Export... 
Zmáčkněte tlačítko Export…pro exportování změřených dat ze zobrazeného protokolu například do 
Excelu. Po zmáčknutí tlačítka se objeví toto dialogové okno:  
 

 
 
Vyberte požadovaný Plug-in a zmáčkněte tlačítko Export…  
 

Tisk (Print...) 
Zmáčkněte klávesu Print... pro tisk jednoto nebo více protokolů v závislosti na označení protokolů 
v listu. Zobrazí se dialog tisku.  
 

Obecné (General) 
Zde můžete vidět minimální a maximální hodnoty (X/Y) stejně jako název programu. 
 

Okna (Windows) 
Pokud vyhodnocovací program využívá okna potom jsou zde informace nastavení okna v horní části a 
v dolní části výsledky vyhodnocení okna. Pokud nejsou vyhodnocení použity objeví se text „n.a.“  .  
 

Změřené hodnoty (Meas. Values) 
O jednotlivých hodnotách křivky jste informováni v položce Meas. Values. 
Pro zobrazení vybraného bodu v grafu klikněte dvakrát levým tlačítkem myši na požadovaný bod. 
V požadovaném bodě se objeví referenční kurzor. Pravým tlačítkem myši v grafu můžete kurzor 
znovu vypnout! 
Pokud chcete změnit barvu křivky je to možné v General Settings ->Graphic Colour Settings. 
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Obálka (Envelope) 
Pokud jste vybraly program obsahující obálku (od DIGIFORCE® firmware V200304) potom je 
zobrazena přídavná karta s názvem Envelope. Pokud je zapnut parametr sledování trendů je zde taky 
zobrazen. 
 

Extras 
Zde můžete najít hlavní informace o souboru protokolu a o jeho původu. 
V této části jste také informováni o chybě během měření a o datech, která tento soubor obsahuje. 
 

Přiblížení (Zoom) 
Pro přiblížení je zamýšleno použití Zoom. Máte na výběr Manual, Auto a z(from) DIGIFORCE. 
 
Ruční (Manual) 
V tomto režimu (Manual Zoom) zůstávají hodnoty rozsahu stálé podle hodnot v polích X-min /        
X-max / Y-min / Y-max.  
 
Automatické (Auto) 
Při tomto nastavení jsou všechny křivky zobrazeny celé a hranice zobrazení se průběžně mění.  
Z DIGIFORCE 
Vyberte tuto variantu pokud máte v úmyslu zůstat v grafickém rozlišení DIGIFORCE®.  
 
X-min / X-max / Y-min / Y-max 
Tyto hodnoty reprezentují hranice zobrazení. V ručním režimu mohou být upravovány 
 

Přibližování pomocí myši (Capture the zoomed area with the mouse) 
Při držení klávesy CTRL, když je zmáčknuté levé tlačítko myši se zobrazí čárkovaný 
obdélník, který se po puštění levého tlačítka myši roztáhne na celou plochu grafu. 
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Tisk protokolů (Printout Protocols) 
[Measure -> Search and edit Measurement Protocols -> Search Protocols -> Open -> Printout 
Protocols] 
 

 
 

Výběr (Selection) 
Selected Protocols  Pokud vyberete více než jeden protokol zároveň (klávesami CTRL nebo SHIFT 
a myší). 
 
All Protocols  vybere všechny protokoly v seznamu 
 

Nastavení tisku (Printing Options) 
Stránka (Page) 
jsou vytvořeny oddělené stránky pro každé měření. 
 
Seznam (List) 
Přehled všech vybraných protokolů ve formě seznamu. Každý řádek odpovídá jednomu měřícímu 
procesu. Maximum řádků na jednu stránku je 40. 
  
Pole křivek (Curve array) 
Všechny označené procesy jsou zobrazeny jako pole křivek, podmínka je, že protokol obsahuje  
křivku a nedošlo k chybě přenosu. Toto nastavení dává smysl jen pro výběr stejného programu při 
měření shodných částí. Z tohoto důvodu jsou vždy ukázána zdrojová data.  
 
Vytisknout obálku a křivku trendů (Print Envelope and Trend curve into graphic) 
Pokud první označený protokol měření obsahuje obálku aktivací tohoto nastavení má za následek tisk 
obálky a/nebo křivky trendu grafické formě (není možné pro seznam). 
 
Jako možnost může být každý tištěný protokol doplněn jménem a nezávislým popisem. Pokud toto 
není vyžadováno musí být tyto pole smazána.  
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Definice seznamu zařízení (Definition 
Device Group) 
 
Co je to skupina zařízení a jaké výhody pro nás má?  
 
V podstatě řečeno, musíte vybrat mezi seznamem zařízením a skupinovým seznamem. Zaprvé 
přístroje nalezeny pomocí „Search Devices“ jsou zobrazeny v seznamu zařízení (seznam mající na 
začátku symbol přístroje DIGIFORCE).  
 

 
 
Odtud jsou vybrány a dány do seznamu skupiny zařízení (skrz tlačítko  „Device Group for 
Measurement Mode” pod seznamem zařízení).  
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V praktickém příkladě může být nezbytné vyhodnocování více výsledků samostatných elementárních 
operací na jedné části nebo na skupině částí a následné uložení do jednoho společného skupinového 
protokolu. Například upevnění 8 kroužků do sedla ventilu a uložit do společného souboru. 
Pro zajištění této skutečnosti obsahuje DIGIFORCE možnost vložení do skupiny. Čtení dat je 
provedeno v pořadí, ve kterém jsou přístroje zobrazeny v seznamu. V našem příkladě 2 přístroje 
kontrolují 8 operací. Vstupní a výstupní kroužky jsou kroužky jsou vtlačeny do každého sedla ventilu. 
Pozice jednotky cylindru Z1 a Z4 jsou v logickém sletu. Také je možné, že všech 8 operací zajišťuje 
jediný přístroj. Potom by zařízení bylo v seznamu skupiny 8 krát. Rozdíl mezi jedním výsledkem je 
v parametru „Name in the group“!  
 
Skupina zařízení: 
• obsahuje stanice, které jsou vybrány ze seznamu přítomných zařízení pomocí funkce „Search 

devices“ nebo pomocí „Reload Device List”. 
• musí obsahovat minimálně jedno a maximálně 32 zařízení DIGIFORCE. 
• může obsahovat vícenásobné vybrání stejné stanice. V extrémním případě může jedna stanice být 

vypsána 32 krát v seznamu skupiny. 
• může optimalizovat rychlost sběru dat výběrem členů v chronologickém pořadí jakém byly 

prováděny operace. 
• přináší společnou skupinu výsledků, které odpovídají sumě výsledků jednotlivých členů. Tyto 

výsledky mohou být uloženy odděleně v souboru protokolů nebo vytištěny. 
• vytvoří statistiku jednoho vyhodnocení za všechny členy skupiny během měření. 
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Nastavení skupiny zařízení (Configurations 
on Device Group) 
[Search devices -> Device Group for Measurement Mode -> Settings] 
 

Vytvoření skupiny zařízení (Create a Device Group) 
Podmínka pro vytvoření skupiny zařízení je, že stanice musí být obsažena v seznamu zařízení. Toho je 
možné docílit pomocí shledání zařízení nebo nahráním seznamu zařízení.  

 
 
Vyberte pokud chcete mít všechny zařízení (all devices) nebo jen jedno zařízení (one device) do 
seznamu skupin zařízení. Pokud jsou v seznamu už přidány zařízení, můžete určit jestli budou vloženy 
před nebo za označený řádek.  
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Název ve skupině (name in the group) může být dán do každé vložené skupiny. Toto jméno slouží 
pro oddělené během vyhodnocování protokolu. Proto vyberte jméno, které dává smysl a popisuje 
úlohu, která je spojená se skupinou. 
Standardní nastavení jména je sériové číslo stanice. 
 
Následující screenshot ukazuje, jak je možné pojmenovávat ve skupině. 
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Vytváření skupinového protokolu (Create group protocols) 
Po aktivaci tohoto zaškrtávátka „Create group protocol“ můžete vytvořit skupinové protokoly jako 
skupinu samostatných protokolů. Je zde zobrazen jeden výsledek pro skupinu zařízení. Skupinový 
protokol může být později vytištěn jako náhled nebo jako jednotlivé stránky k jednotlivým operacím. 
 

Čítač výrobního čísla produktů (Part serial no. counter) 
Pro pohodlné rozlišení vyrobených součástí v pozdější době si může uživatel určit specifické nastavení 
pro čítač výrobního čísla (part serial no. counter). 
 
Běžící čítač každou sérii (Running counter per batch): Pokud je například dávka nastavena na „day 
counter“ (jednodenní čítač) a je 235 den od začátku roku pak sériové číslo (part serial nos.) bude 235 
plus číslo čítače. To bude vynulováno na 1 pokud se změní typ dávky (např. z denního na týdenní 
čítač. 
  
Běžící čítač každý component (Continuous counter per komponent): Sériové číslo (Serial No.) je 
tvořeno s popisem v poli „Component name“ a běžícím čítačem. Ten je nastaven na 1 pokud se změní 
„Component name“.   
 
Běžící čítač (Continuous counter): Čítač sériového čísla přidává jedničku po výsledku každého 
komponentu. Když překročí maximální hodnotu  2147483647 nastaví se na 1.   
 
%1 a  %2: Dobrovolné firemní parametry mohou být vloženy do těchto polí. Tyto pole se během 
měření nemění. Pole %1 je vloženo před a pole %2 je vloženo za číslo čítače! Tímto způsobem je 
možné vytvořit specifickou alfanumerickou kombinaci. 
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Nastavení (Configuration) 
Component name: Popisuje komponentu, která je vyhodnocována jako jednotlivé výsledky ze 
skupiny částí. Toto pole musí být vyplněno jinak bude nastavena na „Not Init“! 
 
Poznámka (Note): Může být volitelně vložena a uložena společně se skupinovým protokolem. Například může 
být použita pro oznámení testovacího provozu po změně nástroje. Maximálně 30 znaků! 
Série(Batch): Volitelné jsou automatické čítače denní „Day Counter“ (série je číslo dne v roce), číslo týdne 
„Number of Week“ (odpovídá číslu týdne v roce) nebo manuální výběr „Manual Definition“. Manuální výběr 
zůstává stejný. 
  

Přečíst skupinu (Readout Group) 
Postupně (In sequence): S tímto nastavením jsou všechna zařízení načtena v seznamu zařízení 
přečtena v nastaveném pořadí. Mimo to je možné nastavit ukončující podmínku jako je například  
„(stanice poslala NOK výsledek)a station sends the evaluation result NOK“ nebo “(stanice na začátku 
seznamu poslala nový výsledek) the first station in the group list sends a new result” pro přenos 
výsledků měření NOK z časových důvodů optimalizace s tímto nastavením. 
Každý(Any): S tímto nastavením jsou členové skupiny dotazovány na nový výsledek měření 
v opakujícím se kruhu. Pokud je dostupné nové měřené jsou data přenesena, tento člen není přístupný 
do doby dokud nejsou načteny data od všech ostatních členů skupiny. (S výjimkou: zařízení je první 
v seznamu a je vybráno “finish the group ahead of time if there is a new result in the first station”)  
 

Přerušit skupinu předčasně když… (Terminate Group prematurely, if... ) 
výsledek stanice je NOK (a station results NOK): Může být určeno jak postupovat, když výsledek 
stanice je NOK. Pokud je vybráno „Terminate Group prematurely, if  a station results NOK“ potom po 
načtení výsledku NOK je následně ukončeno skupinové vyhodnocení. To dává smysl například, když 
jediný vadný kus znehodnotí výsledek všech ostatních součástí. Součást by měla být zpracována, 
manuálně zkontrolována a eventuálně zpracována i přes NOK výsledek. V tomto případě všechny 
členové skupiny musí být přečteny. Dávejte pozor na READY- signál všech DIGIFORCEů! Pouze se 
signálem READY=1 může být stanice spuštěna pro nové měření. 
Nový výsledek v první stanici (New result in first station) (pouze pro „in Sequence“):  
První zařízení v seznamu skupiny dodává výsledky měření a později udržuje nové výsledky ve stejné 
skupině. Tento výsledek spustí PLC před dokončením skupinového měření, kontrola skupiny je 
zastavena a následuje další výrobní číslo. PLC rozhoduje o ukončení skupinového testu kvůli NOK 
signálu z jednoho zařízení pomocí restartování prvního člena skupiny. 
 

Další tipy 
Vyhodnocení skupiny (Group evaluation) 
Výsledek skupiny je OK pokud výsledky jednotlivých členu skupiny jsou OK. Výsledek skupiny je 
NOK pokud minimálně jedno zařízení pošle NOK nebo pokud není výsledek nějakého zařízení 
přečten.  
 
Konfigurace přes „Repote kontrol“ pomocí řídící komunikace (Configurations „Remote 
control“ via control communication) 
Většina nastavení skupiny zařízení můž být změněna nebo přečtena přes řídící komunikaci. Jako 
výsledek výrobní číslo (part. No.) každého měření může být nastaveno v DigiControl pomocí PLC se 
sériovým rozhranním. 
  

Velikost polí (Field sizes) 
Velikosti proměnlivých polí jsou definovány následujícím způsobem:  
Part no. „%1“ / „%2“ : každý maximálně 32 znaků 
Part no. counter: maximální hodnota = 2147483647 
Component name: 32 znaků 
Remark: 64 znaků 
Manual definition charge: 32 znaků 
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Důležitá rada 
Pro ujištění se, že budou zachyceny všechny výsledky měření DIGIFORCE musí být respektován 
READY mód pro všechny měření. Jen při READY=1 stanice může začít nové měření.
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Statistika skupiny zařízení (Statistics on 
device group) 
[Search devices -> Device Group for Measurement Mode -> Statistic] 
 

 
 
V levé části grafu je vidět rozložení OK/NOK všech členů skupiny. Zobrazené barvy jsou rozděleny 
následujícím způsobem: OK = zelená, NOK = červená a nedostupné = žlutá  (pro skupinu „Terminate 
group prematurely, if...“). 
 
Výsledek může být  zobrazen jako linear nebo parallel. 
 
V pravé části můžete najít vyhodnocení celé skupiny. Tento sloupec je aktualizován jen pokud je 
skupinový protokol vyžadován. Pokud se načítání čísel z libovolného důvodu zastaví, statistika není 
aktualizována. 
 
Statistika všech členů skupiny a celková statistika je nulována Reset Statistic. 
 
Důležitá rada:  
- „Search devices“ vždy způsobí vynulování předchozí statistiky! 
- Skupinové statistiky a nastavení skupiny jsou ukládány/nahrávány kdykoliv se ukládá/nahrává 
soubor zařízení. 
  


